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Présentation
de la formation

Objectifs

-

Objectif principal : Maitriser les bases pour la création de
cartographies et la manipulation d’informations géographiques dans
le cadre de la gestion forestiere.
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Lundi Mardi Mercredi Jeudi Vendredi
08h00 - 08h30 Accueil
(@) bJ ectifS 08h30 - 09h00 Ouverture CR du lundi CR du mardi CR du mercredi CR du jeudi
Présentation des participants et Présentation 3 : Présentation 4 : Présentation 6 : Analyses |Echanges sur les besoins
R 09h00 - 05h30 animateurs Topométrie Télédétection spatiales en compléments
05h30 - 10h00 Objectifs::slz:;imd:)i::t: attentes TD 3I:Iil:]rvéepnat:1i:ieon de TD6: Mraa:it;:iation de TD 8 : Analyses spatiales Explicatio.rls et E)fercices
10h00 - 10h30 Pause Pause Pause Pause Pause
Les outils sont nombreux et complexes : maitriser parfaitement la 1or30- 11000 | Présentation 1 Geomatiaue etSie
ca rtographle et Ia teledeteCtlon demande beaucoup de prathue' 11h00 - 11h30 TD 1 : Installation de QGIS TD 4 : Mesures au GPS TD 7 : Classification  [TD 8 : Analyses spatiales L .
Explications et exercices
. . . s . lé i
L'objectif de cette formation n’est pas d’étudier toutes les 11h30 - 12h00| 7D 2 Prise en main de QIS COMPEMETIEHES
fonctionnalités des outils, mais de : 12h00 - 12h30
. o . . 12h30 - 13h00 Repas et priere Repas et priere Repas et priere Repas et priere EvaluatiorT tel
= Comprendre les outils existants et comment ils servent la gestion iiaie
BN 13h00 - 13h30 Echanges
forestiere,
13h30 - 14h00 TD 2 : Prise en main du SIG TD9: Cloture
* Se familiariser avec I'utilisation de certains de ces outils pour des oo ool Présentation 2 Rétarentiels et | 1041 Mesures auGPS | 107 Classfication | Production/impression
~ coordonnées
taches courantes, 14h30 - 15h00 Pause Pause Pause Pause
= Savoir comment se former pour la réalisation de taches plus 15h00 - 1530 : : 105 Chargementdes | Présentation s ™9
D 2 Rise en e S données GPS dans le SIG | Télédétection appliquée Produc?lon/lmpresswn
com plexes. , 15h30 - 16h00 d'une carte
;Em : 16h00 - 16h30 Quizz 1 Quizz 2 Quizz 3 Quizz 4




TDa : Installation de QGIS

Installer QGIS sur les ordinateurs des participants

Date : lundi matin
Durée : 30 min
Lieu : salle

Mode : installation par chaque participant avec aide des
formateurs si nécessaire

TD2: Prise en main du SIG

—

Ouvrir le SIG

Charger, comprendre (table attributaire) et manipuler (affichage)
des couches vecteur (points, lignes, polygone)

Charger et comprendre (histogramme) une couche raster
Géoréférencer une carte

Créer ses couches vecteurs : numériser quelques villes (points), un
troncon de route (ligne) et des foréts (polygones).

Manipuler les options d'affichage de ces couches

Calculer la surface des foréts

TD2: Prise en main du SIG

—

Date : lundi matin et aprés-midi
Durée : 2 heures

Lieu : salle

Mode :

1. Manipulations du SIG par les formateurs, projection et
répétition par les participants pour la prise en main

2. Exercices individuels ou en bindbmes puis explications
collectives

Document support :
Fiches d’aides a QGIS Sigea : fiches A01 a CO06 ; fiche G02
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Elaborer un échantillonnage systématique sur SIG, sur la s‘l'Jrface du
CFPF ; Exporter les points sur GPS

Date : mardi matin

Durée : 30 min

Lieu : salle

Mode :

Manipulations du SIG par les formateurs, projection et répétition
par les participants

Document support :

Présentation 3. Topométrie




TD4 : Mesures au GPS

Retrouver les placettes sur le terrain avec la fonction FIND
Faire un inventaire trés simple

Prendre des points sur le terrain, fonction MARK
Sauvegarder un tracé sur le terrain

Estimer une surface sur le terrain

TD4 : Mesures au GPS

—

Date : mardi matin et apres-midi

Durée : 2 heures 30 min

Lieu : en extérieur au CFPF

Mode :

Exercices individuels on en binbme avec aide des formateurs
Document support :

Manuel de démarrage rapide du GPS Garmin GPSMAP78

2l Tara 10

TDs5 : Importation des données GPS

—

Charger les données GPS dans le SIG

Manipuler ces données

Date : mardi apres-midi
Durée : 1 heure

Lieu : salle

Mode :

Manipulations du SIG par les formateurs, projection et répétition
par les participants

Document support :

Fiches d’aides a QGIS Sigea : fiche GO1 et présentation 3.
Topométrie

Ouvrir un raster, observer I'histogramme, changer |'affichage.

Date : mercredi matin
Durée : 30 min
Lieu : salle

Mode : Manipulations du SIG par les formateurs, projection et
répétition par les participants pour la prise en main

Document support : Fiches d’aides a QGIS Sigea : fiches BO1 et B02




Utilisation de I'extension Semi-Automatic Classification : émarger
une image, observer les bandes, créer des régions d’intérét (ROI),
lancer la classification

Date : mercredi matin et apres-midi

Durée : 2 heures 30 min

Lieu : salle

Mode :

1. Manipulations du SIG par les formateurs, projection et
répétition par les participants pour la prise en main

2. Exercices individuels ou en bindmes puis explications collectives
Document support : tutoriel sur SCP

TD8 : Analyses spatiales

—

Analyses vectorielles (tampon, intersection, e 3 ’
découpage...); Analyse de terrain sur raster (calculatrice, pente...)
Date : jeudi matin

Durée : 2 heures

Lieu : salle

Mode :

1. Manipulations du SIG par les formateurs, projection et répétition
par les participants pour la prise en main

2. Exercices individuels ou en bindmes puis explications collectives
Document support :

Présentation 6. Analyses spatiales et Fiches d’aides a QGIS Sigea :
fiches DO1 a D05

Améliorer la présentation des informations cartographiées : styles et
étiquettes

Utilisation du composeur d’impression :
= afficher la carte,

= afficher une légende,

= afficher une fleche Nord,

= insérer un titre et un logo.

Date : jeudi apres-midi
Durée : 2 heures

Lieu : salle

Mode :

1. Manipulations du SIG par les formateurs, projection et
répétition par les participants pour la prise en main

2. Exercices individuels ou en bindbmes puis explications
collectives

Document support :
Fiches d’aides a QGIS Sigea : fiches EO1 a FO4

¥
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1. Géomatique

P1
Géomsaltquue et 2. SIG
SOMMAIRE Géomatique : définition
[
1. Géomatique /Geomatiq\ue)
Géographie Informatique

Ensemble des outils et méthodes permettant d’acquérir,
représenter, analyser et intégrer des données géographiques.
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Géomatique : contenu

-

#

3 domaine d’activité : /
mp®santes :

Description d’objets / phénomeénes localisés, par les ¢o

Collecte des informations géographiques : mesures de distances,

. iaue : ol est-il situé / ol s'& il 2 Lobi o
angles, altitudes, mobilisation du GPS et de la télédétection. Géographique : ol est-il situé / ol s’étend-il ? Lobjet est situé dans

un systeme de coordonnées.

Traitement des informations géographiques : calculs d’aires, de
distances, représentation de zones d’intérét, classification des
données, mobilisation d’'un Systeme d’information géographique
(SIG).

Sémantique : quelle est sa nature ? L'objet est caractérisé par des
attributs (type de formation forestiére, n° de parcelle cadastrale,
volume de bois a I’hectare, statut de protection).

Topologique : quelles sont les relations entre objets/phénomeénes ?
La délimitation de l'objet dépendant d’autres objets (parcelles
contiglies, desserte forestiere bordant les parcelles, inclusion des

Diffusion des informations : élaboration de cartes, publication sur
internet (Webmapping, par exemple https://www.google.fr/maps)

,:r . foréts dans des communes). ;;m 6
2 &
& L - )

Information géographique : représentatio Information géographique : représentatio
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SOMMAIRE

2. SIG

T
=
o

Systeme d'information géographique :
définition
o

Le SIG a pour but de rassembler, au sein d’un outil unique, des
données diverses mais localisées dans le méme espace
géographique, relatives a la fois a la Terre et a ’'homme, a leurs
interactions et a leurs évolutions respectives. Ce rassemblement
permet d’élaborer les syntheses indispensables a la prise de
décision.
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Systeme d'information géographique :
définition
o

Le SIG permet de

= gérer et traiter les relations spatiales entre objets ou
phénomenes dans |'espace terrestre, ce qui implique des fonctions
d’analyse spatiale et de synthese pour 'aide a la décision

= représenter visuellement I'espace sous la forme d’une carte ou
d’un plan, ce qui implique des fonctions de conception et de
production cartographiques

T
=
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Systeme d'information géographique :
définition
o

Un SIG doit permettre de répondre aux questions suivantes :

Ou ? Les objets doivent y étre localisés

Quoi ? Les objets y sont définis (batis, foréts, cours d’eau...)
Comment ? Les relations entre les objets doivent pouvoir étre
déduites (c’est de I'analyse spatiale)

Quand ? Les données doivent pouvoir étre mises a jour et les
historiques conservés

Et si ? Il doit étre possible d’y effectuer des simulations.
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T
s




Couches

-

Les données sont regroupées par couches homogenes.

Une couche rassemble un méme type d’objets (ex : couche routes,
végétation, réseau hydrographique, population, etc.)

Dans une couche, tous les objets sont définis par une méme liste
de caractéristiques, appelées attributs (par ex pour une route :
longueur, largeur, type, goudronnée/non goudronnée, etc.)

Dans une couche, les objets sont de formes du méme type (des
points, des lignes, des polygones).
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Fonctionnalités : 6A

-

Acquisition : on y intégre des données géographiques et on y
saisie leurs caractéristiques

Archivage : le SIG permet de gérer le stockage des données
Analyse : on manipule, croise et transforme les données

Affichage : des cartes peuvent étre produites en fonction des
besoins

Abstraction : le SIG modélise le monde réel

Anticipation : il est possible de modéliser un futur probable

15
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SIG : outils existants

-

Il existe une grande quantité de logiciels SIG.

Les plus connus sont les suivants :

{£.Q6GIs
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Horth Pode

P2

Référentiels et
coordonnées

Réferentiel et coordonneées

-

Pour localiser un objet sans
ambiguité, a la surface de la terre, il
faut :

= Connaitre la forme de la terre

= Fixer un référentiel

= Exprimer les coordonnées de
I'objet dans ce référentiel

T
tgw
N

Geéodesie : la forme de la terre

Puison a i ’
On 2 dabord o , Et e'nfln gu’elle
¢ i uis remarqué n‘a pas de
p_le_nse que parfaitement qu’elle tait « forme
e”f fta't sphérique aplatie aux mathématique
ate O
p poles parfaite »

La géodésie est I'étude des dimensions et de la forme de la Terre.

T
b Torma

Géoide et ellipsoide

-

Le géoide représente l'altitude O a la surface de la Terre : c’est le niveau
moyen des océans.

Comme il est irrégulier, on ne peut calculer des coordonnées
géographiques automatiquement. On utilise des ellipsoides pour
approximer localement le géoide.

Géoide
Ellipsoide global

Ellipsoide local

T
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Systémes de coordonnées

-

Les systemes de coordonnées ou Systemes de référence terrestre
(SRT) sont des référentiels qui permettent de localiser des points
dans I'espace :

Le systéme cartésien permet de localiser n'importe quel point,
mais ne tient pas compte de la forme de la Terre.

Coordonnées cartésiennes : M (X, Y, Z)

W
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Systémes de coordonnées

-

En associant un ellipsoide au SRT, il est possible de localiser chaque
point en tenant compte de la forme de I'ellipsoide (donc de la
Terre). On parle de systéeme géodésique, permettant d’utiliser des
coordonnées géographiques.

i LA R T

Coordonnées géographiques : M (A, @, h)

A = longitude et @ = latitude,
généralement en DMS (degrés, minutes,
secondes) ou degrés décimaux.

h = altitude, généralement en métres.
_i‘:‘..m
e

Systémes de coordonnées

-

Pour représenter les objets sur des cartes planes et pour faciliter
les calculs, on projette I'ellipsoide sur des plans. On obtient des
systemes plans. Une projection déforme toujours les surfaces,
angles ou distances.

Coordonnées en projection = coordonnées

E = distance vers I'Est, par rapport a un
point de référence.

N = distance vers le Nord, par rapport a
un point de référence.

Généralement en meétres

-

¥
Eal Tarwa
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Systémes de coordonnées
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Systémes de coordonnées

Systeme de coordonnées Parametres

Cartésiennes Référentiel

Géodésiques Référentiel + ellipsoide

Planes Référentiel + ellipsoide + projection
o
oy b, TiRRR 9
]

Systémes de coordonnées de référence

L'European Petroleum Survey Group (EPSG) a dé

Systémes de coordonnées de référence (SCR) et les a codifié.

Ces SCR sont inclus dans le logiciel QGIS que nous utiliserons cette

semaine.

On peut passer d’'un
SCR a l'autre par des
transformations.

Lk el SR, Vg
= X Carbéa
Pl b il sl dea_ Caw R W A
Sk s, e MR Eoal s, o st m
R Ceanous Sy Bos S TG EFaG: I
o AR Dz i ;
rar i _Pode AT B EFSS TN
Todh Pule_toenthl Euekcioni e ]
e _Srentad_Fpideiu L P T L]
il Barashel Eoucdaias EPSG: 40T
o Evr fhwera da e
Lo Bamsl Bonre LS J2IET
| & k- _. S T B
SR asbachard ;T
l:!«. 10
1 ke Tera

L]

Systémes de coordonnées de référence

WGS84 (World Geodetic System 1984) : Systéme global tres utilisé,
initialement mis au point par le département de la défense des Etats
Unis en 1984, mis a jour en 2004. Son ellipsoide se nomme IAG-
GRS80.

Choisir un systeme de coordonnées unique pour toutes les
informations d’une cartographie est essentiel.

Lt un
L

-

SalvaTerra

Bureau d’études en environnement, forét
agriculture et développement rural
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P3

Topométrie

Topomeétrie : définition

P

Topographie {mesurejet[représentation|sur un plan ou un€ carte des

formes et détails Misibles sur le terrain
Cartographie

Topométrie : déterminer la position et
I'altitude de n’importe quel point.

Planimétrie : déterminer la
position (x;y) des points
situés a la surface de la

Terre

Nivellement = altimétrie :
déterminer l'altitude (z) des
points situés a la surface de la
Terre

-

.‘)'\
]

Mesure directe des distances

P

Méthodes de mesures approximatives, en terrain relativement plat :
double décametre, topofil.

Attention distance
non horizontale

A -

Mesure directe des distances

P

Chainage par cultellation.

'y
Fil 2 plomb r -
i
E: O Dbnvele = Soimine 0o mesurss A5 = C0
E E +EF
G|g: Décamétre Distanca horizontsls * somme des mesures 8C + DF *
c Talus

.‘)'\
]

-
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Nivellement direct

e
Wiy
flir
T Pk )
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A dner = La-ke

Nivellement direct

-

Exemple d’'un cheminement « fermé »
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Outils de mesure indirecte

-

Position da tas hdomitne

T
tg-—

Théodolotite
Mesure d’angles
horizontaux et
verticaux

Tachéométre
Mesure d’angles
horizontaux et
verticaux et de
distances

Topométrie et points de référence

-

Avec les méthodes de topométrie exposées jusqu’ici, Il est'hécessaire
de disposer de points de référence dont on connait les coordonnées
(longitude, longitude, altitude).

C’est ce a quoi servent les points géodésiques.

Il faut également savoir comment
est orienté le systeme de
coordonnées. Par exemple :

= axe k : Vertical

= axe i : Nord-Sud

= axe j : Ouest-Est

T
tgw
©
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Le GPS

Le systeme de positionnement mondial (Global Positioning System ou
GPS) se base sur I’émission d’ondes radio par des satellites en orbite
autour de la Terre et leur réception par des récepteurs GPS (appelés

couramment GPS). _ )
= Les distances aux satellites

permettent de localiser le GPS.

Le GPS affiche sa position par
des coordonnées, en référence
au systeme géodésique
mondiale de 1984 (World
Geodesic System ou WGS84)

X
Elub Toutra 9
L

T

Topomeétrie et gestion forestiere

-

La topométrie est mobilisée pour la gestion des foréts, en
particulier :

= Routes
* Inventaires (localisation de placettes, surface des placettes)
= Zonage/stratification

10
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Préparer un inventaire systématique avec
QalIsS
e

Wectmur
Oaf2shp
Editeble GroC5v
GRS
Graphes Rodters
DpenStectiap
Heguéte Soausle
saigte de coordonndse

Ouvrir la fonction Points réguliers

Verifcater d= opooge

!_ Dutis_dr rechesche |+ Ponis aléatores 3 lintEnewr des oolygones (variabie)
Dutlz de péatraiterent I créer unpolygone & partr o2 l'emprise dune cotche
Outiz de peométre ~  selection par locateaton
Dutls danalyse 1o Poinis slfatores & lintiiewr des polygones (fics]

* ¥ w v w w w w ®w Ow w v w

Outde d= pestion de données '@ Seection slEatnre parmi des sous-snsembles

s Ponis alfatores dans ' ttendue
Grile vecteur
17y Pomis sléatores dare les bmites de & coudche
o Sélecion akatore
B Porms réguiers i

Préparer un inventaire systématique avec
QalIsS

-

B amad

iy fry e e nal

SO, i e iR, LR

Tzt v § reyreg ol gy

R R
L T )

.l =

A O i D e
] e i, e el
Frrdy regremy
e DL T ]

e e B e i ] e L
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Préparer un inventaire systématique avec
Qals

-

[ A

Avec un clic droit sur le nom de la couche de

point, lancer « Enregistrer sous... »
W W Prirds sty -

o TR TR

M arirdee [ ipegy
1 Fapmumc
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Gatda P il e vvad 03
Tl T e i
Do w i IEF pht poial dap i brdix copchs
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T PRI LT =y ]
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Préparer un inventaire systématique avec
QalISs

R
Semak | 00 michayg booeni i)
= v O e e Tyl e el
Lo
= Renseigner les parametres :
B Ml by [T Sy lll'.lF-l"F': By s 0T
< bt = Format GPX
foody i gk e
T el
iy — = SCR WGS84
B B i [ v prare |
PP e e iy e
[T W
|l e = L R R e e
v Fi SyEiadied i
P o
| T oyt i i o v
o rmn Ty “

Préparer un inventaire systématique avec
QalIsS

-

A Garmin GPSMAP 64s (F:)
. Garmin
.. BirdsEye
. CustornMaps

. Current
. Nav

| Echantillen.gpx

. CustermnSymbels
. BxtData

.. Filters
. GGZ Enregistrer le fichier GPX
ki GPS dans le GPS

. GPX
. Current
. MNav
. Profiles
. saL
o Text
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DIRECTION NATIONALE DES EAUX ET FORETS S O M M AI R E

PROGRAMME DE GESTION DECENTRALISEE DES FORETS - GEDEFORIII

1. Définitions
2. Spectre
électromagnétique

P4

Télédétection 3. Acquisition d'images
4. Résolution spatiale
5. Traitement d'images

6. Classification des images
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SOMMAIRE

Qu'est-ce que la télédétection ?

e

1. Définitions L'O.N.U. définit la télédétection comme étant
“'observation de la surface terrestre a partir de
l'espace en utilisant les propriétés des ondes
électromagnétiques  émises, réfléchies  ou
rétrodiffusés par les objets observés. Ceci afin de
faciliter la gestion des ressources naturelles et de la
protection de l'environnement.”
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Bases physiques

e

Cette définition est un systéme qui peut regrouper un
ensemble de paramétres et phénomeénes qui interagissent
dont I'on retient quatre principaux éléments :

— Le rayonnement électromagnétique;
— La scéne (ou cible ou objet étudieé);

— L'environnement de l'objet;

— Le systeme d'observation.
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e

Cheminement du REM

& *3&#‘*5.

Source de REM 4— Iap r
T N‘" /s R. émis par
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R. incident 4 R. émis

R. réfléchi

Surface au sol
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Principes de base

-

Détection

(_images )

[Trai:tements d'images & contrdles terrain ]
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Ce qui existait avant
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Landsat — Extraction d'information

e

)

L.

09 ..

Classification
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Base de connaissances

-

LANDSAT O

Points de contrdle o

SRTM e
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© SPOT vegetation

© PRL

10

Capteurs existants

o
LANDSAT IKONOS QUICKBIRD
O’ﬁ" 500 km
SPOT

RADARSAT

o

ASTER

11

Orbites

-

e Orbite héliosynchrone

e Une orbite héliosynchrone
permet de s'assurer que le
satellite survolera toujours
a la méme heure solaire
locale une région
quelconque de la planete

3
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Inclinaison
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2. Spectre
électromagnétique

Tt
L3 ek

13

-

Reflectance

Interaction de I'énergie

Propriétés spectrales

| = Incidence

A = Absorbtion
R = Réflectance
T = Transmission
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Spectre électromagnétique

SPOT L
IKONOS
QuickBird RADARSAT
i
N
F 2
RAYOS | RAYOS X RAYOS X ULTRA R ‘INFRAROUGE ~RADAR —>
GAMMA (Intensos) (Debiles) VIOLET R STHERMIQUE UHF VHF
R 2
u
G L VRADIO
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Longueur d'onde

Longueurs d'onde
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Basse fréquence  Haute fréquence
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Ce que l'on voit... ou que I'on ne voit pas

L'ceil agit comme filtre pour
ne conserver que les
longueurs dans une étroite
bande du spectre

L Toiera 17

3
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Réflectance et signature spectrale

-

Chaque objet, en fonction de sa composition, renverra les REM
de différentes longueurs d’'ondes avec différentes intensités.

L'évolution de l'intensité (réfléctance) en fonction de la longueur
d’onde caractérise la signature spectrale d’un objet.

Un méme objet peut avoir différentes signatures spectrales en
fonction de sa composition.

T 18
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Variété spectrale

o

Signature Spectrale

123 456 7

Bandes
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Bandes spectrales

o

- Végétation

+Végétation \/
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Potentiel du multispectral

=

Bleu Cartographie des cours d'eau, humidité des sols
Vert Indice de la santé des végétaux, réseau routier
Rouge Distinction des types de végétation
Proche Densité de la végétation & distinction des especes
infrarouge de végétaux

Types de roches et minéraux
Infrarouge . . :

Structure géologique, zones urbaines
moyen e

Délimitation des types de cultures
Infrarouge . o
lointain g Températures, types de roche, types de minéraux
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3. Acquisition d'images

3
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e

Principes d'acquisition

b1 b2 b3

Reflexion

g
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4. Résolution spatiale
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Qu'est-ce qu’un pixel ? Reésolution spatiale

e

e

i5m oom

» Plus petit élément échantillonné e
L

» |l estalabase de la composition d'une

image _

= Plusieurs pixels forment une image W\
) ) _ gom =, 1 plxeldegom

= Sataille définit la résolution de cette [ \) i/ équivaut a 36 pixels

image de15m
= Dans saforme initiale, il est localisé dans ) \ B g

Iimage par un N° de colonne et un N° de & /%_)

l —

gne
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SOMMAIRE

Qu'est-ce qu’une image ?

-

Quand on utilise le terme
IMAGE, on consideére
I'ensemble des bandes
spectrales qui
correspondent en effet a
d’autres images

Bande 3

Bande 2 5. Traitement d'images

o ,_F
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Traitement d'images

-

Ensemble des opérations qui doivent étre appliquées a
Iimage de sorte a exploiter au maximum le potentiel de
I'information qu'elle contient

3
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29

Atmosphere

3
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30

Précision radiométrique

e

.... Veut dire la “qualité” de la valeur enregistrée

.. Pourquoi?

1. Faire le lien avec une librairie spectrale
Peut améliorer la qualité visuelle de I'image
3. Faire le monitoring

W
S Tama 31

3

o

e

Superposition d’'information

requiert que chaque couche
d’information soit parfaitement
superposée de sorte a ce que les
valeurs de chacun des pixels se

géomeétrique est ESSENTIELLE

3
[ e

Une analyse multi dimensionnelle

chevauchent. Une bonne correction

32
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SOMMAIRE

Procedure de classification

e

Application d’'un Calcul des Classification Application des Etapes de Post
masque qui signatures Bayesienne floue seuillages afin classification
couvre les zones spectrales a partir en utilisant les 6 d’isoler chacune
dénudées calculé des points de bandes de des classes
a partir du NDVI controle LANDSAT
6. Classification des images
o »
A Toma 33 A Toma 34
e T
Calcul d'une signature Dimension spectrale
= =
Pour chaque‘ pixel qui Foréts
correspond a une méme o
. et [ ]
classe identifiée sur le o
. [ ]
terrain nous calculons ® .
une signature
Tous les points de controle de méme classe ont été mis ensemble Distribution des valeurs
et les valeurs spectrales de chacun d’eux ont été fusionnées de
sorte a obtenir une signature spectrale moyenne représentant la
classe de végétation.
3,-._’m 35 3,-._’m 36
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Dimension spectrale
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Vecteur spectral

37

Classification

Demixage spectral

— Logique floue

— Dempster-Shafer

— Analyse discriminante
— Stratification

— Maximum de vraisemblance

— Sans supervision

38
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Classification

T

Fournir une valeur thématique a
chacun des pixels de I'image en
fonction d'une légende pré-
définie

Foréts

Végétation peu dense
Plantations

Mais

Blé

Sols nus

Riviéres [ lacs

Zones urbaines

]
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DIRECTION NATIONALE DES EAUX ET FORETS

PROGRAMME DE GESTION DECENTRALISEE DES FORETS - GEDEFORIII

4 . % ¥ -f'.j_rf i Ed
P6
Analyses
spatiales

Analyses spatiales

-

Un SIG ne fait pas qu’afficher des informations géographiques. Il
permet également de faire des analyses pour :

= Générer de nouvelles informations
= Etudier les relations entre les objets cartographiés

Par exemple, on peut chercher a calculer une surface des foréts
facilement accessibles par les routes, calculer une proportion de
foréts sur des fortes pentes, calculer la surface de forét dans une
entité administrative (commune, région...).

¥
Eal Tarwa 2
-

T

Analyses spatiales

-

Les outils d’analyse spatiale sont tres nombreux. On ne présentera
ici que les plus utilisés pour la gestion des foréts.

Pour réaliser I'analyse voulue, il faut généralement utiliser
plusieurs outils dans un ordre précis.

-> |l n’y a pas de catalogue de solutions pour toutes les
problématiques : il faut savoir utiliser les outils et les combiner.

-> Cela demande surtout de la pratique.

T
=
w

SOMMAIRE

1. Outils pour les vecteurs

2. Outils pour les rasters

W
s
ES

29



SOMMAIRE

1. Outils pour les vecteurs
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Outils de recherche (1/2)

Dutl

Fonction

Foink slealoies
a linférizur des

Génare fes podnts aldatoires & I'mtérieur des paipgones dune couchs donnés (densité

palygones régianie pour chagles polygone)
{varlable}
Cléer un polvgona
£] a partif da Crée une couche contenant un polygone simple (rectangle} couvrant l'etendue d'une
- lemprse dune | couchs rasier ou vedewr, oo un redagle par entile
couthe
g Sdedion par | S&lecionns des sniités en fonclion oe leur refalon spatiale par rappart & une autre
W localisation couche (utilisaton des pradcats topologigu es)

Faoints algatoims
a Nntérieur des
polygones (fixes)

Gankre oes points aEatoires 3 Nnéneur 0es polygones dune coichs dannée (nomere ou
densié de points fixnés)

Seleciion sleatore
parmi des soue-
ensambing

Sélecionna sléattirement des enlités aU s2in g Smis-ensembies définis psr un champ
fdentflant urique, e e pas de nouvelle much e

-
tg'x
o

Outils de recherche (2/2)

-

Selechon satore
panTi des sous-
ensemnies

Séledionne sldatoirement des aniiiés au sain de sous-ensembis délinis par un champ
identifiant unigue, Ne cree pas de nouvelle couche

Folntszléatips
dans l'alendue

Ganare gas pohts akkaloires dans dsslimiles fisdas par Iutilisateur [comdamdas)

Gellig voctour

Gdnkre une gnile fommée par des |ignes ou A8 pol ygones A pany dun espacamyent oétni
par [ulilisalpur

Poinls zleatones
d&ns les limies oe
la eouens

Geéngéme oes ponts aléatoires dans les imies dune couche donnes

Sélection akatore

Lélacionne aléatoirement un nombre-ou un paurcentage n dentités ke crée pas de
nouvelk couche

Faints réguliers

Géngra.ung grile réQuiBre de points sur uns tone spécifids B) S expoite &n ung couche
da poims (shapafile)

Erp——

Outils de géotraitement (1/2)

-

Outil Fonction
iitarsachion Superpose deux couches et crée une couche résuitat contenant uniquement les swrfaces
""" des deux coudies qui sont superposaes.
Ditférencision | Superpose les couches et crée une couche résultat ne contenant que les sirfaces des
symatrique deux couches qui ne 200t pas SUpeMOsées. ’

Distance tampon

Crée une(des) zone(s) tampon autour des enties . hasée(s) sur la valeur dun champ

variable donne.
Cilton Superpose deur couches ef crée une coliche résultat contenant fes surfaces des deux
coudies qui se croisent et celies qul ne se crolsent pas.
Gicaani Regroupe les entités adjacentes au selon un champ. Toutes les a;_'m'!és ayant desvaleurs
(Regroupsmant) Identiques de ce champ sont regroupéas pour former une ssule entité.

Attention -~ pas de caicul de surface agrénée lors du regroupemant

-
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Outils de géotraitement (2/2)

P —
& .
‘--’l Diffétence Superpose deux couches et crée una coliche résultat contenant Tas surfaces de la couche
danirée (cible) qui ne croisent pas celles de la couche de découpage.
‘ mm“?ﬂm’nn Crée uneides) zanels) tampen autour des entités, basée(s) sur une valeur fike
r‘-' ol Superpose delx couches el crée une couche résultat contenant les surfaces de la couche
pe dantrée (cibia) qui sont superposées 3 celles de la couche de découpage.
' Supprimer les | Fusionner les entités sélecionnées avec ke polygone voisin de plus grande suface
dépordements | ou de plus grande fronfigre commune.
.r Enveloppe Crée |'enveloppe minimale convexe pour une couche donnée ou des sous-ensemoles
convexe définis par un champ identifiant.

-
‘FE:‘
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Outils de géo

meétrie (1/2)

m—

lcéne Outil

Fonction

—

T8 | verifier i valigts

Werifie I3 validite d'une couche vedorielis. Les entites sonl dassees en 3 groupes valide
invalide st ameur

.P' Darsifer las Densde les polyignes ou les polygones en ajoutant des fomeds {nomtire flnd par

géomélries luflliezteur)

|/ﬁ3' Centroides de | Orée une coudhie de points, centroides de chague enlbité dune coudie de polygomes.

b polygones Atterthon | le ceninioe peul Bire SiL6 en dehors de l'entite

)

L4 De fignes a Canverfil une couthe de palyignes femmées en ure couche e polyponed
polygones

J"--‘_l_l o | i

e % "‘r’c"ﬁ;jm 3| Canvertil una couche de palvgones en cauche de palylignes

? D& morceau
mulpias 3

MOTCESUN Bnigues

‘ Sdnde uneeniié mutiple en plusieurs entités simples Crée des polygones el des fgnes

gimples 3 partic de muld-polygonas ou de muti-poignes.
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Outils de géométrie (2/2)

m—

—_ —
Smplieria Generalise les polylignes ou les polygones (dminuion du nomare ce noeuds)
Saretis Aftenton | Ies graphes DISTaTes e 50Nt DEa CONSEvES, (85 polyDOnes elant péneraisas
g indépendamment les uns des aulres
L] ~ .
\‘ Extraction de | Edrait les noeuds d'une coucha de polgignes ou da polygonas et ranvola une couche de
roeuds points.
‘ Triangulation de | Calaule e renvaie (en lan! que polygones) |3 anguistion de Delaunay dune couche de
Crelaumnay paints
Che misrce gus
unigues 2 Compose des enfles mulfiples (mulli-polyligne ou mullipolygone] = parlif de plusisurs
moncaaux enfités simples poszédant e méme identifiant sur un champ donng,
muitpies
l,-"_ Exporterajouter | Ajoute des informations de géameétne sur une coudhe vecteur de points (XCO0RD,
ges colonnes: | YCOQORD), dedgnes (LENGTH- fongueur), ou de polygonas (AREA - aire, PERIMETER -
de géomdtrie | pérmatre),
- Polgones & | 000 1ae polvganes de Vorandl dune couche de paints
igronoi T

11
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Outils d'analyse (1/2)

P —
leéna| Cutil Fonction
:0: Coordonnés(z) | Cacule & centra moyen namal ou ponderé saoit d'une couche we dsur ensérs. soit des
moyanneds ) eniites partageanl un méme identifiant
Eiz Bratsuques
= basiguss sur les | Cdcule des stalisfiques de base sur un champ lexts donne
champs de fexe
! Analy=e du plie | Cacyle des slafishques surls plus proche vaisin polr Svaluer i nheau de ragraupemeant
proche valsin dans une couche de points:

12

-
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Outils d'analyse (2/2)

-

Crae une tatle contenant |8 mesure (s tetances entre deux coudhes de points et renvos
las résutats sous la forma da

pasigues cur les
champs

Matnice des a) Matrice de distance standard,
distances b} Malice des distances en ligne,

o) Résume des distances [moyanne, min, mad, &ear lype)

Il est possible de lmiter les distances 2ux n entllés les plus proches
Stafisiques

Carule des stalisiques de base sur in champ numerigue donng

numéiques

——

t':f;;&: RIS |} e toutes Jes yaleurs unioues diun chamo d'une couche vecteur

% Somme des Eﬂ:;“;r;mﬂ;ﬁi:nii longueurs 11e nambre total ds |lgnes crolsant chague ntité
|angueus
des lgnes

Outils de gestion des données

P =
ledne Qutil Fanction
L Séparar una
v couhe Sépare une couche en de mulliples couches dstinctes salon un chamg didentfiznt
vecaur
= Jaindre les Jaint des aributs supplémestaires & une couche Yecteur en fonchan de 12 bncalisation
\ sitriuts par {utlizstion des prédictas opologigues) Les amributs dune couche vaoteur sont ajoutés &
localisation caux d'une aufre coudhe & expordss dans une nowvelle couche shapefile
04 Définir la Dafini 2 sysme de coordonndes pour les shapeles aul n'en mauraient pas
projeciion couranie

J’ Créarun ndex

Créée un index apatial pouwr la couche spicitée

spatial
Fusionner des | Fuslonne les shapeles prsents dans un réparnire &n un nousesy shapens gz méme
couches vactaur |type (point ligne ou polygone)

J’ Refadarser |es

Crée une nouvelle couche en modifiant les chames dune couche exstante

champs
;'ém 13 ——
SOMMAIRE Calculatrice raster
i b
ll..!._l'-- avves, FO) | SO00eInE MOALTNLT T
B.lnbl |:l\.l-u.l| hp\m . :
S o Inl 1 caleul du NDVI : (Proche
i R e g = Infrarouge - Rouge) /
TR (Proche Infrarouge +
. 2 : ' " - = i Rouge)
2. Outils pour les rasters o mo e
1 1 = - - Bt ]
T T (indice de végétation
.. i w ot B e e g e W i | =] par d,:fférence
normalisé)
{ LI [ CEww
;'ém 15 ;'ém 16
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Analyses de terrain

Un Modeéle numérique de terrain (MNT)
est un raster dont chaque pixel renseigne une altitude.

Sur la base de MINT, les outils d’analyse de terrain permettent de
calculer:

= |a pente : en degré d'inclinaison

= |'exposition : orientation du terrain (en degrés de 0 a 360°)

= |'ombrage : aspect des ombres du terrain (en paramétrant la
source lumineuse)

= |e relief : représentation sophistiquée du terrain superposant trois
composantes pour obtenir une apparence 3D.

® |'indice de rugosité : mesure de I'hétérogénéité du terrain
&ff..m 17
]

Carte de chaleur

=

Une carte de chaleur identifie des
« points chauds », c’est-a-dire les
zones dans lesquelles des objets de

trouvent en forte densité.

i
il Tera 18
L

W

Interpolation
& .. - I' 4 = : I .".
4 L b &
o "t i e
& 3 ll' a L L - l
- .l = i L F .m
- | = & *i i "- '1 ;" L3 .‘-l
] " N . 7 B T » oL -
LI o -.F '. ;- . ‘
. . . N e am oy
Linterpolation consiste a calculer st RGTS L o
. . , LA " .iﬂ . 't
des variables en tous points d’un . "R ..
raster a partir de données 1 ;_ti;'_{_ ‘%} .-' k.
R e "
;.é.m - 19
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Sigea ediiter

Réalisation : fabien.guerreiro @ gmail.com.
http://www.sigea.educagri.fr

Fiches d’aide a QGIS

Versions 2.16.x & 2.18.x

Site officiel
http://www.qgis.org/

=
¥
Utilisation des fiches

Ces fiches sont créées dans un but de formation ou d’autoformation, dans un esprit non
lucratif.

Vous pouvez donc réutiliser le document dans son intégralité, ou fiche par fiche si besoin,
selon la licence cc by-nc-nd 2.0.

L’utilisation de ces fiches est simple, il faut comprendre le sommaire pour retrouver les
manipulations du logiciel.

Les fiches ont été réalisées avec les versions 2.16.3 et 2.18.0 du logiciel.

Les captures d’écran sont issues du logiciel QGIS (GNU — www.qgis.org), associées a des
données personnelles.

Symboles utilisés :

(‘j : Point d’information

g Point d’attention

g : Manipulation du logiciel

W : Nouveauté du logiciel depuis la derniére version LTR (2.14)

N’hésitez pas a me contacter pour toute suggestion.

http://creativecommons.org/licenses/by-nc-nd/2.0/fr/

Fiches d’aide a lutilisation de QGIS

QGIS_A - Présentation du logiciel 1
QGIS_AO01 - Utilisation et possibilités du logiciel............ccoceciviiiniiiniiiiiiicnieeen 2
QGIS_AO02 - Environnement du IoZICIel.......cccevueririiriinieiininieneceeieneee et 3
QGIS_AO3 - Interface et barres d’OULILS .........ccveeeriierieiiicreecieeeee et e e e 4
QGIS_A04 - Le Projet QGS......oomiieieiiiieeieieieieetete ettt ettt ettt ebe e 5

QGIS B - Gestion des couches 6
QGIS_BO1 - Ouverture et fermeture d’une COUCNE .........coevvirieieriieieiececiereee e 7

QGIS_BO02 - Gestion visuelle des couches (propriétés du projet et d’une couche) ..

QGIS_BO03 - Affichage des données attributaires a 1’écran .... .9
QGIS_B04 - Connaitre et modifier la projection d’une couche...........ccceceverueirencncnnnne. 10
QGIS_C - Structure des couches 11
QGIS_CO1 - Création d’une COUCNE .......c..couiiiieeiiicieeeiieeie ettt eve et eveeevae s 12

QGIS_CO02 - Editer des données
QGIS_CO03 - Création de champs attributaires............cccecvecererenieieinenieieeneceeeeeeee
QGIS_C04 - Création d’objets graphiques .........c..cceeveverieireninieiiineieeeseet e
QGIS_CO5 - Modification d’objets graphiques .
QGIS_CO06 - Modification d’objets SEMANtIQUES ........cc.eeveerrerrerieirerenieieeneeeeeeesee e

QGIS_D - Analyse spatiale 18
QGIS_DO1 - Sélection par attributs (requéte attributaire) ..........cceecevereeeeereneereneneneneenes 19
QGIS_DO02 - Sélection géographique (requéte g€ographique) ..........ceceevvereeveeneereenienennens 21

QGIS_DO03 - Jointure attributaire/ Jointure spatiale
QGIS_DO04 - Outils d’analyse spatiale : VECIEUL .........cccereeeeriirierienienieieneeieneeieeeeseeeeens
QGIS_DO5 - Outils d’analyse Spatiale : TASLET .........cccevuerveererierieieenenieieenresreeere e seeeenes

QGIS_E - Analyse thématique/Sémiologie/Symbologie
QGIS_EO1 - Symbologie/ Affichage simple des entités............ccccovvvvuicirieiiinniniiccninnenne.
QGIS_EO02 - Analyse thématique/ Affichage avancé des entités..

QGIS_E03 — Etiquetage des NS ..........coovviuiiiiiiiiiiiiiiiiiciicccicceeeneeserec s 28
QGIS_F - Mise en page 30
QGIS_FOI - Création d’une miSe €N PAZE .....c.cevereueruerienieirierienteiietenieneeseerestensestesessesaeneenes 31
QGIS_FO02 - Qréation d’une 18Zende.........cceveriiniriiiinie e 32
QGIS_FO03 - Eléments d’une mise €N PAZE .........cceveuiriimiuiiiiuiiiiiiiiieiciricieieeeeeneceene s 33

QGIS_F04 - Exportation de la MiSe €N Pae.......c..cceeerierieirierienieieienienieieiesienieeeiesieseeneenes 34
QGIS_G - Intégration de données externes 35
QGIS_GOI - Ouverture de données tabulaires (txt, csv, dbf), GPS et autres ..................... 36
QGIS_GO02 - Géoréférencement d’images : Données rasters...........cvevueveenenieenencnnenne. 37
QGIS_GO3 - Ouverture de protocoles Internet — WebServices (WMS, WES...)............... 38
QGIS_G04 — Connexion et gestion de bases de données ............ccecevevieieeneniecenencniennne. 39

2

34



o

OGIS A - Présentation du logiciel

QuantumGIS (QGIS) est un logiciel permettant d’exploiter un Systeme d’Information
Géographique (SIG).

Un logiciel SIG permet 1’acquisition, le stockage, la mise a jour, la manipulation, et le
traitement de données géographiques. De plus, il permet de faire de la cartographie et de
I’analyse spatiale de facon précise en fonction de I’échelle désirée.

Le principe directeur d’un SIG est le suivant : nous avons d’un coté les données géométriques
et de I'autre les données attributaires, liées a ces données géométriques. Ces données sont
stockées sous format numérique et organisées par couches.

QGIS est sous licence libre (GPL) téléchargeable en frangais sur le site http://www.qgis.org/.
Vous trouverez d'autres logiciels libres en géomatique tel que GvSIG, OpenJump, Udig,
Grass...

QGIS installe des logiciels tiers qui possédent leur propre licence. Liste des logiciels
installés :

1. QGIS

2. ECW Raster Plugin for GDAL

3. MrSID Raster Plugin for GDAL

4. SZIP compression library

5. Oracle Instant Client

D’autres composantes nécessaire a des utilisations spécifiques sont installées telles que :
- GRASS (orienté traitements d’images),
- SAGA-GIS (orienté hydrologie, analyse de paysages,
- QT (interfaces graphiques),
Sous licence GNU-GPL
- Python (langage de programmation) sous licence libre Opensource (compatible GPL)

Liste des fiches :

QGIS_AO01 - Utilisation et possibilités du logiciel
QGIS_A02 - Environnement du logiciel
QGIS_AO03 - Interface et barres d’outils

QGIS_A04 - Le projet QGS

F. Guerreiro 1
Mise a jour 1c-n

QDepuis la version derni¢re version LTR (2.14), I’extension fTools a
" été supprimée (analyse vectorielle remplacée par un autre module - Lo.p L,

OGIS_A01 - Utilisation et possibilités du logiciel

— QGIS est un logiciel SIG (Systtme d’Information Géographique) open source

multiplateformes (Windows, MacOS, Linux).

QGIS Respecte les normes de I’OGC (http://www.opengeospatial.org/). Il est associé avec
une norme de métadonnées respectant la norme européenne ISO 19115.

QGIS a vu ses débuts comme logiciel de cartographie et s’est développé au fil des années
pour s’imposer parmi les logiciels SIG libres les plus performants.

Outre les fonctionnalités de base que 1’on retrouve dans les SIG, comme la saisie, 1’édition, la
consultation, I’interrogation et la mise en forme de données géographiques, on retrouve le

principe des extensions, destinées a ajouter des fonctionnalités a la version de base.
L’utilisateur a la possibilité de développer ses propres extensions en Python.

Fonctionnalités présentes dans le logiciel par le biais d’extensions ou non (non exhaustives) :

- Exploitation de diverses sources de données telles que les serveurs distants (SQLITE,
MySQL, POSTGIS (avec I’extension eVis), ORACLE, ODBC ESRI database... et via
les protocoles WMS, WFS...), les fichiers tabulaires (txt), les bases de données, les
imports et exports (TAB, Dxf, gml, shape, postgis, €00, gtx, kml)...

- Création et édition de données

- Edition des attributs et des objets géographiques (avec gestion topologique telle que le
snaping ou fusion des limites)

- Géoréférencement des fichiers raster au format Tif, JPG, Gif, ASC, IMG, ECW ou
Png...

- Gestion et reprojections (systemes de projection européens et mondiaux intégrés au
logiciel selon les codes EPSG — www.epsg.org)

- Géotraitements (buffer/tampon, intersection, union, jointures spatiales, moyennes...)
et sélections

- Exploitation graphique (histogrammes...) des données attributaires

- Cartographies thématiques (qualitatives ou quantitatives) et production cartographique
(échelle dynamique, nord, légende)

gVoiCi la liste des 22 modules disponibles par défaut a I’installation de QGIS 2.16 & 2.18 :
£ —— = —
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e Al L Tl Thed
. e e chalez
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Les modules précédés d’une croix sont activés par défaut. Les BLyamr
extensions en ROUGE ont été mal installées (raisons techniques). : :E"LW_"‘ f;:
. . . . . P Tt h: Chare
La liste est disponible depuis le menu Extension > Installer/Gérer e ke e
les extensions : % Installer/Gérer les extansion o R
I - Sl o oo srTsas
W i cnr de plorere

d’analyse). 1 ....I:ahn B oo e

F. Guerreiro 2
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0GIS_A02 - Environnement du logiciel

@QGIS est classiquement composé d’une barre des menus et de barres d’outils variées selon les
besoins.

C’est a partir de la barre des menus que 1’on acceéde a la plupart des fonctions de QGIS.
Projet Editer Wue Couche Préférences Extension \Vecteur Raster Basededonnée Traitements  Aide

Du fait de son historique a orientation cartographique, QGIS possede des menus orientés vers
cette derniere, et des menus complémentaires, traitant plus spécifiquement des SIG.
La plupart des actions de ces menus sont repris sous formes de barres d’outils (cf. fiche A03).

Le menu Projet (nouveau, ouvrir, fermer ou enregistrer des projets...) est classique des
logiciels couramment utilisés. Le projet est le fichier dans lequel les travaux seront
enregistrés. Reportez-vous a la fiche A04 pour en savoir plus sur le projet.

Le menu Editer (copier, coller, ajouter ou supprimer...) permet d’accéder a toutes les
fonctionnalités d’édition d’entités géographiques fiche C04 et CO5).

Le menu Vue permet d’accéder aux outils de déplacement et d’interrogation des données
géographiques.

Le menu Couche gere la possibilité d’ajouter ou retirer des couches (vecteurs, rasters ou
WMS) du projet, ainsi que les actions classiques de gestion des couches (voir les attributs des
couches ou activer 1’édition de couche...).

Le menu Couche, accessible par sa barre d’outils qui reprend les actions, est aussi
partiellement accessible depuis un clic-droit sur le nom de la couche.

Les outils relatifs a Uacces aux informations (cf. barre d’outils Couche> Accéder aux
informations de la fiche A03 si besoins) ont une action sur la couche ACTIVE donc
surlignée en gris !

Le menu Préférences referme 1’acces aux propriétés du projet et celles logiciel en général.

A partir du menu Extension, vous obtiendrez les extensions du logiciel installées sur votre
ordinateur. Ceci permet notamment de les activer ou les désactiver. Des extensions
supplémentaires sont disponibles, par exemple sur le site officiel http://pyqgis.org/ .

Le menu Vecteur integre des fonctionnalités de géotraitement sur les couches vectorielles,
alors que le menu Raster integre les fonctionnalités de traitement des données sur les rasters.

Les menus Base de données, Internet et Traitements viennent compléter les menus des
versions précédentes ; le premier reprend les diverses extensions (BD Manager, Evis, ...) qui
offrent des options différentes de connexions aux bases de données ; le second regroupe les
outils liés a la publication Web des données, alors que Traitements permet d’utiliser la boite
~aoutils de géotraitements, pour une accessibilité rapide.
@De nombreux outils d’analyse (notamment sur GRASS) y ont été ajoutés.

Le menu Aide renferme des éléments d’aide complémentaires et de I’ Internet si besoin.

OGIS_A03 - Interface et barres d’outils

g Interface e

l—l =T
g s e + . b~ i a1V Fiche A02
~ QGIS est a I'image de i o (_ fc ° )

i K o g o -n =@
nombreux logiciels SIG, Barres d’outils S -

composé : (Ci-dessous) -
- d’une partie supérieure
avec les Menus et Barres e T i IH_F-,
d’outils, Wi l"{f_“-...,__
- d’une partie gauche qui # T
contient les noms des - .I Affichage des couches |
couches ouvertes, g = I R
- d’une partie droite pour i #
I’affichage géométrique F
des entités des couches, i b o
- d’une partie supplémentaire i
en bas a gauche depuis le
menu Vue >Panneaux. ¥ i

Nom des couches

Panneaux
Supplémentaires

9 Barres d’outils
" Les barres d’outils reprennent les fonctionnalités présentes dans les menus.

Barres d’outils

Barre d’outils Projet P R

| LTS S —————————r—

Gestion des projets Barre d’outils Couche N b S R
Ajouter des informations (données) |5 s s ccarie e

B aim tmr yp= ks T S
~ . Ajout de données supplémentaires
= (exemple : bases de données)

En cliquant sur la fleche noire

Barre d’outils Vue
Evoluer sur la vue
ik ok il T
Barre d’outils Attributs
Accéder aux informations de la couche ACTIVE!

QBarres d’outils supplémentaires
Barres d'outils Editer : Modifier Jesentités  Autres barres d'outils et Extensions

Barre d'outils Raster
AL

K i ; o T [ s

Barres d'outils d’Extensions : Exemple Grass

Barre d'outil Grass Menu (Extensions> Grass)

& Dwve b decimey

—_—
= Ll

N

L'extension doit étre

préalablement activée
depuis le menu Extensions

e

Modifier des entités
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OGIS_A04 - Le projet OGS

“aLa mise en forme des différentes fenétres, 1’ordre de superposition des couches, le choix des
~ styles pour les objets cartographiques, le positionnement des étiquettes, la 1égende etc. sont

autant d'opérations qu'il est intéressant de sauvegarder pour ne pas avoir a les reproduire a
chaque ouverture de QGIS.
Ces éléments ne sont pas enregistrés dans les couches. Le projet de travail (Projet QGIS) vous
permet de sauvegarder une session de travail (format du fichier : *.qgs).
Voici un exemple de fichier .qgs ouvert avec un éditeur de texte :
T e e L T el

v brm brwn geea s (Rem jreesm oww e w— =

\

|
|
¥ % . : i
—ioanis = — ris.nir ll_ Propriétés et statut
1| des couches
]
B |

—y T ettt :?- Etendue de la vue

Projection des couchesj

——————

""\iPour enregistrer I’état d’avancement de votre travail dans un projet, allez dans le menu Projet
>Sauvegarder le projet.

Le projet est un fichier unique qui ne contient pas de données géographiques. Il renferme
simplement une série d'instructions qui est donnée a QGIS et qui précise I’emplacement des
données utilisées dans la session, 1’état des vues (fiche B02) ou mises en pages (fiche FO1), la
mise en forme des objets, etc... Plusieurs projets peuvent utiliser les mémes couches de
données dans des mises en forme différentes. Le projet contient des instructions sur les
couches a utiliser (il enregistre le chemin d’accés aux fichiers utilisés, relativement au projet),
& ail est indispensable de préserver ces couches telles qu’elles sont lors de l'enregistrement du
- projet. Si, une couche est déplacée ou renommée (sans déplacer tout le dossier du projet et des
couches), QGIS vous demandera ou est enregistrée la couche a la prochaine ouverture du
projet. ! = T =
A I’ouverture du
logiciel, la partie i tme
centrale « vue », Sl -
propose directement :
I’ouverture des
derniers projets.

2.5
pe
I

iy > Parametres de la vue

s ] Parametres, d’affichage,
L T —— . SRR de la légende....

OGIS B - Gestion des couches

2 La gestion des couches est essentielle pour bien démarrer I’apprentissage du logiciel.

~ Bien comprendre comment s’organisent les couches les unes par rapport aux autres et
comment s’organise ’articulation entre la donnée géographique et la table attributaire qui lui
est associée, est la base de la compréhension des logiciels SIG.

Une gestion approximative des couches peut générer de nombreux problemes d’analyse,
affichage...

Liste des fiches :

QGIS_B01 - Ouverture et fermeture d’une couche
QGIS_B02 - Gestion visuelle des couches (propriétés du projet et d’une couche)
QGIS_B03 - Affichage des données attributaires a I’écran

QGIS_B04 - Connaitre et modifier la projection d’une couche
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OGIS_B0I - Ouverture et fermeture d’une couche

Ouvrir une couche

Pour ajouﬁter un vecteur, allez dans le menu Couche >Ajouter une couche >Ajouter une couche
vecteur (\/; Ajouter une couche vecteur... o Ctri+Maj+V)  Choisissez le fichier que vous voulez ouvrir en
fonction de son type a partir du bouton Parcourir, sous le type de source Fichier.

Pour ajouter un raster, allez dans le menu Couche >Ajouter une couche >A jouter une couche raster
(¥, Ajouter une couche raster... oy cisMaj+R). Choisissez le fichier que vous voulez ouvrir en fonction de
son type. L’ajout d’une couche se réalise aussi depuis la barre d’outils Couche (fiche A03).

Ouvrir une donnée Clerm b e s il

. T PRl -1

A% 1 . Rt i i I
E e e
C Ares
T an
E |
U
R
1 - Parcourir les données
R b b e e e 1% ]
A 'y
S rr_'r?_ll-
T LA it - 1
E It Types de vecteurs
R =

2 — Choisir le type
de fichier a ajouter

T

| ST = s
Attention : Si le systeme de projection du fichier a ouvrir n’est pas renseigné, ou s’il est différent
de celui de la Vue, sans que la projection a la volée soit activée, il se peut que vos données ne
soient pas superposées correctement ! (Reportez-vous a la fiche B04).

Il est a noter que les rasters n’aiment pas la projection a la volée et nécessitent souvent de travailler
dans un systéme de projection unique et adapté...

Pour ouvrir une image NON géoréférencées, reportez-vous a la fiche GO2.

Le choix du Type de fichier lors du parcours des fichiers influe sur le type de fichiers visibles dans le dossier
courant ! Exemple : si vous choisissez Fichiers de type : ‘ESRI shapefiles SHP’, les fichiers de type DXF ne
seront alors pas visibles pour 1’ouverture.

-y dmim pEazw me

L s e wml

- NPT

Ouvrir une couche locale (ordinateur) type Shp, Tiff... : cf. Ci-dessus

Ouvrir une table de base de données PostGIS, spatiaLite...(fiche G04)

L st emeam

; T: A .r--_I = m.  Ouvrir une couche distante (Web) type WMS, WES... (fiche GO3)
PP —
:.;: I.: o : ':'_ILI""" ~ De nouveaux services de données sont accessibles depuis le
e i : < menu Couche >Ajouter une couche (DB2, carte ArcGIS,
T} it Rl couche d’entités ArcGIS)

il s e

w

w

OGIS BO02 - Gestion visuelle des couches (propriétés du projet et d’une couche)

Propriétés du projet (ou de la vue)

La Vue est I’organisation visuelle de la superposition des couches. C’est de cette fenétre que
I’on gere et observe toute I’analyse spatiale et le requétage sur les couches. La vue est
associée au projet.

Propriétés de la fenétre vue

Nom de la vue (nom du projet)
4

g !
t

| Projection

-Superpositiol{_:","~ -
des couches

F owow e s

(‘ Unites

cartographiques

Lim @riin)s]
Echelle - Rotation \
de la vue %‘74 Loupe de la vue

« zoomer » sans

=¥ o difier I'échell
(= Projection de la vue modier Techete

@ La projection de la vue se régle en tout premier lieu, dans le menu Projet >Propriétés du projet
>SCR ou bouton [@), avant d’ajouter des couches!!

Attention, par défaut, « Activer la projection a la volée » est pas coché; il permet (lorsque la
projection d’une couche est renseignée), de reprojeter visuellement celle-ci.

- La superposition des couches se geére par glissement du nom des couches les uns sur les
autres. L’ordre de visibilité des couches dans la vue est lié a I’ordre des noms.

- Les couches visibles dans la vues sont les couches cochées % .

- Les actions du menu Couche ont une incidence sur la couche surlignée en gris (active).

Propriétés d’une couche
Un clic droit sur le nom de la couche, puis Propriétés permet de gérer les onglets suivants :

-

Général Style

Modifier I’alias du nom de la couche Modifier le rendu de la
Modifier la projection de la couche couche, sa transparence

e 3 g =g
Etiquettes Champs e i Rgndg -
Etiqueter les entités en Paramétrer les champs Simplification du
fonction d’un champ présent de la table attributaire rendu visuel
dans la table attributaire |

Jointures
Créer des liaisons entre
attributs de tables

Actions
Lancer des scripts
sur la couche

Infobulles
Information affichée
dans les infobulles

l.“ Daromres

Métadonnées Variables

g Fermer une couche

Pour enlever/ fermer une couche présente, un clic droit sur son nom, puis Supprimer L4 réalise
I’action (cela n’efface pas la couche de 1’ordinateur), ou depuis la barre d’outils Couche (fiche A03).

Diagrammes Lire les caractéristiques de la

Variables d’environnement

Ajoute des diagrammes en
baton ou camemberts a

couche (emplacement, projection...)

F. Guerreiro

Mise a jour : déc. 2016 — cc by-nc-nd 2.0

I’apparence de la couche i Légende &
- Ajoute des éléments accessibles depuis le
F. Guerreiro panneau couche (ex. : barre de transparence) 8
Mise a jour : déc. 2016 - cc by-nc-nd 2.0
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OGIS_B03 - Affichage des données attributaires a I’écran

Dans la vue (fiche B02), a

partir du menu Couche | Lien entre les données graphiques et attributaires
(clic-droit sur le nom de la o

. Un clic-droit sur le nom de la
couche ou delllS la barre couche pour

B 3 3 Montrer dans I'apercu
d’outil Couches - Fiche | oo cioptoni ine

A03)’ sélectionnez Ouvrir miniature de I'étendue de la
couche

la table d’attributs pour
afficher les données
attributaires d’une couche.
La couche doit étre
ACTIVE  (surlignée en
gris).

Lorsque 1’on sélectionne
une entité sur la vue, a
l'aide de Toutil Sélection | |i-—=
du menu Couche (Oll Sil'apercu n'est pas affiché : Menu Vue >Panneaux,
depuis la barre d’outils - puls cocher Apereu

A "

Table attributaire
—— e el

0OGIS_B04 - Connaitre et modifier la projection d’une couche

< & Vous devez ceuvrer dans un systeéme de projection unique dans la mesure du possible.
" Les projections sont exprimées dans QGIS selon leur nom et les codes EPSG' correspondants.

&9 Afficher ou renseigner la projection (se gére en amont du travail)

- Projection de la vue :
Au moment de I’ouverture du projet, donc de la vue, vous devez indiquer la projection de ce
projet. Ceci a une influence sur I’affichage de toutes les couches (cf. encadré fiche B02) :

<4 = | Voici la méme couche, départements de France en Lambert 93, affichée
=% | selon une vue en L93 a gauche, et selon une vue en WGS 84 a droite.

i

fiche A03), la ligne Remarque : la sél_ection d_'ung en_tité sur I -
N la carte avec l'outil sélection implique la E

correspondante  a I’entité sélection des données associées dans la : -
est sélectionnée dans la table attributaire et inversement. |

table (et inversement).
Le nombre d’entités sélectionnées est inscrit dans 1’entéte de la table attributaire.

Les outils de la Table attributaire (disponibles depuis une table attributaire est ouverte) :
- Outils de sélection : | * Y B S PRE 0

Lorsqu’une sélection est activée par sélection sur la carte ou sélection d’une entité (simple clic sur une
ligne) ou plusieurs lignes (a I’aide des touches CTRL ou MAJ lors de clics suivants), vous retrouvez
au-dessus de la table attributaire (respectivement des boutons ci-dessus) : Sélection par expression,
Tout sélectionner, Inverser la sélection, Désélectionner, Sélectionner les entités en utilisant le
formulaire‘f—", Placer la sélection au début de la table, Centrer la vue sur la sélection, Centrer et
zoomer la vue a I’échelle de la sélection, Copier et coller la sélection dans/depuis le presse-papier.

. Outisédition:| 2| B S B A R K E
Lorsque le « stylo » (premier bouton) est activé, soit Basculer en mode édition, les boutons suivants
(respectivement, Basculer en mode édition multiple%”, Sauvegarder les modifications, Actualiser
les modifications, Effacer les entités sélectionnées, Supprimer un champ/ une colonne, Ajouter un
champ/ une colonne, et Quvrir la calculatrice de champ) sont alors accessibles.

Le bouton d’actualisation des modifications est utile dans la mesure ou le calcul d’une colonne
n’affiche pas toujours tout de suite les nouveaux résultats.

Le clic droit sur une cellule permet désormais d’accéder directement au zoom sur I’entité concernée, et
a I’ouverture du formulaire de saisie de cette méme entité (identique au bouton en bas a droite E]
de la table attributaire.

= ER =y
Mise en forme conditionnelle =™ :

Améliorer I’affichage de certains champs de }
la table selon des conditions. !

Exemple : Repérer dans la table les noms de régions 3 [+~ e Fodta |
surface réduite : s 2 1
Regle sur le champ NOM puis cliquer sur | Feom fas [

Condition : "surface" < 500 " R
Réglage : Choisir les couleurs de texte / fond. Ajouter
un symbole. { iy e

A chaque ouverture de la table, les régions de petite l agn
surface seront notées selon les conditions réglées . -

- Projection des couches :
Vous devez connaitre le syst¢éme de projection de toutes vos couches (cf. métadonnées).
Par défaut, QGIS applique la projection définie pour la couche. Cependant :

o Lorsque la projection de la couche est différente de celle de la vue, vous devez
Activer la projection a la volée de la vue (cf. encadré fiche B02).

o Lorsque la projection de la couche n’est pas renseignée, QGIS applique par défaut la
projection de la vue ! La projection de la couche se renseigne par clic droit sur le
nom de la couche, puis Définir de SCR d’une couche ou dans les Propriétés de la
couche (cf. fiche B02), puis =~ #=f=k3R  dans ’onglet Général.

Le renseignement erroné d’une projection peut induire des erreurs visibles (cf. exemple ci-dessous) ou non (calculs de
surfaces, croisements de couches...) : Sur cet exemple de la France, j’ai volontairement
indiqué a QGIS que la couche est en NTF - Lambert Centre France, (en réalité, elle est en

L93, comme le spécifient ses métadonnées) : La conséquence est ici bien visible, puisque
la couche est située 4 a 5000km au nord des autres données, déformée et désorientée.

¢ Modifier la projection d’une couche (Reprojeter)

A partir d’un clic-droit sur le nom de la couche, vous pouvez Enregistrer sous...
Une boite de dialogue de copie de la couche (création d’une nouvelle couche) apparait :
=

= e ——— R — - -

P

1 — Recherchez le
code désiré

2 — Sélectionnez la
projection correspondante

3 — Validez

O = la projection

NB. : En cas de reprojection F‘fangaise, préférez les codes IGNF (recﬁerchei-dans (1) le code désiré) au lieu de
EPSG, pour la couche de départ et pour la couche d’arrivée. Ces codes utilisent la grille centrimétrique de I'IGN
plus précise pour la reprojection.

! Codes EPSG utiles a connaitre (http:/www.epsg.org/) utilisés dans les logiciels :
2154 : RGF93 Lambert 93 ; 4326 : WGS84 world geographic 2D ;

27571 : NTF Lambert zone I ; 27572 : NTF Lambert zone II ; 27573 : NTF Lambert zone I1T ; 27574 : NTF Lambert zone IV ;

NB : Le menu Vecteur> Outils de gestion de données offre aussi la possibilité de renseigner la projection d’une couche
(Définir la projection courante) et de modifier la projection d’une couche (Exporter vers une nouvelle projection).
Le menu Raster> Projection, offre les mémes possibilités pour les rasters.

10
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OGIS C - Structure des couches

3 La création d’une couche se fait en trois temps.
— 1l faut d’abord créer la structure de la couche et bien réfléchir aux informations qu’elle doit

contenir. Il faut ensuite créer les entités graphiques. Enfin, il faut remplir la table attributaire
en respectant bien le lien avec la donnée géographique.

Liste des fiches :

QGIS_CO01 - Création d’une couche
QGIS_CO02 - Editer des données

QGIS_CO03 - Création de champs attributaires
QGIS_C04 - Création d’objets graphiques
QGIS_CO05 - Modification d’objets graphiques

QGIS_CO06 - Modification d’objets sémantiques

11
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OGIS_CO01 - Création d’une couche

La création d’une couche doit étre précédée d’une étape de réflexion sur la modélisation du

phénomene a intégrer dans le SIG. Il s’agit d’un aspect fondamental qui permettra une
utilisation rationnelle et aisée du SIG. Une étape a ne pas négliger !

Tous les objets d’une méme couche doivent étre du méme type géographique (points OU
lignes OU polygones). Chaque objet géographique stocké dans une couche est doté d’un
certain nombre d’attributs (ou champs), qui sont définis lors de la création de la couche, puis
modifiables lors de la modification de la structure de la couche.

Manipulations
A partir du menu Couche, choisissez Nouveau, puis Shapefile, Spatialite, temporaire ou
couche GPS (choisir shapefile par défaut si vous ne possédez pas de base de données) :

1
W', Mouwelie couche shapefie.. Ctrl+Maf+N

L
| Mouvstie Couche GeoPackage..
W houvelle couche temporaine &n mémaira...
12 Créer une nouvells couche GPS

La procédure s’exécute en trois étapes :

1 - Indiquer le systeme de projection (par défaut, celui de la vue est sélectionné).

2 - Choisir le type d’entités a créer (point, ligne ou polygone) et créer les champs
attributaires ou colonnes.

Un champ est ajouté uniquement lorsque le bouton Ajouter a la liste d’attribut est
~ coché ! 1l est possible de créer des champs ultérieurement (cf. fiche C03).

3 - Indiquer ’emplacement et le nom du fichier.

#° houvele muche SpaniaLte... U

Création d’une couche

1 - Entités et Champs
= ol

2 — Projection !! == — — Typedenties
| p—

— = - — i S TE————
- - .. de la couche

Créer un champ
-Texte

-Entier

-Décimal

-Date

Liste des
champs ajoutés

3 - Enregistrement

Projection de la nouvelle couche

= Par défaut, WGS84 par défaut!

= Les actions par défaut se modifient
dans Préférences >Options, puis SCR
pour les actions sur les projections

Chemin et nom d’enregistrement de la couche —

Lorsque la couche est créée, elle est automatiquement ajoutée a la Vue. Cette couche est
vierge. Son nom est noté dans la table des matieres de la vue (partie gauche de la vue), au-
dessus des autres couches.

Pour rendre la couche éditable, reportez-vous a la fiche C02 ; pour créer des entités, reportez-
vous a la fiche CO04 ; pour remplir les champs correspondants aux entités créées, reportez-
vous a la fiche C06.

12
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OGIS_C02 - Editer des données

Toute action de modification sur une couche, que ce soit au niveau de sa structure, des entités
ou de la table attributaire passe impérativement par 1’activation de I’édition.

¢y Editer une couche

La couche a éditer doit étre active, c’est-a-dire surlignée en gris (ACTIVE).

Dans la fenétre Vue, commencez I’édition & partir du menu Couche >Basculer en mode
édition, ou par clic-droit sur le nom de la couche (le clic droit sur la couche vous assure que
vous éditez la bonne couche !).

Le bouton ¥ est alors enclenché | ¢ | (gris plus foncé).
Le nom de la couche ne change pas, les seules modifications sont ’apparition du stylo devant
le nom de la couche et I’apparition des nceuds dans la vue (si votre couche contient des

entités !), comme le présente I’image ci-dessous : [
- AT _/
|r| ;“ | :: hu ‘ |
Lk = —l g T |
— ; L -{_/
e —— i |

L’édition de la structure, des entités ou de la table attributaire peut alors commencer :
- Dans la vue, les barres d’outils d’édition (outils Créer des entités et Modifier des
entités — cf. fiche A03) sont maintenant disponibles (ne sont plus grisées).
- Dans la table attributaire de la couche, les outils de la barre d’outils d’édition (cf. fiche
B03), sont aussi accessibles.

¢—9 Terminer I’édition

Pour arréter 1’édition, procédez de la méme fagon, menu Couche> Basculer en mode
I’édition. Ceci a pour effet d’arréter I’édition de la couche ACTIVE (surlignée en gris !).

NB. : Lorsque vous terminez 1’édition d’une couche ou d’une table, QGIS vous demande
automatiquement si vous voulez enregistrer les modifications apportées. Ceci est trés utile en
cas de d’erreur ou de mauvaise manipulation.

Il est possible de commencer I’édition de plusieurs couches en méme temps; il reste
cependant recommandé de ne faire qu’une seule chose a la fois !
La fenétre ci-dessous est un exemple de message lors de la fermeture du logiciel ; certaines
couches ont ét¢ modifiées, le logiciel vous demande si vous voulez conserver ces
modifications :

L feaeer [edRn i -

ﬂ' rndber- s =gt me b prod@adinas pout be oo e Rdgons |

Swagetry’ | | e pa enregetne Al

¢y Editer une table attributaire qui ne possede pas d’entités (dbf, csv...)

Ouvrez la table a éditer comme une couche vecteur (fiche BOl si besoin) en spécifiant
| Fichieis de type:

[alies 1] oour voir votre fichier dbf par exemple.
La table est alors accessible dans la liste des couches a gauche de la vue —/
(méme s’il n’existe aucune vue associée a cette table), avec un pictogramme ol lgffm
spécifique, comme présenté ci-contre : H dop._stat
Pour démarrer 1’édition, procédez comme pour une couche vectorielle (ci-dessus).

Depuis la table attributaire, les outils d’édition (cf. fiche B03), sont alors accessibles.

OGIS_C03 - Création de champs attributaires

¢ Créer un champ / une colonne

Commencez 1’édition de la couche ou de la table (fiche C02), puis affichez cette table.
Dans la barre d’outil de la Table, choisissez 1’outil Ajouter un champ (fiche B03) :
Lors de la création du champ, vous devez définir tous les éléments constitutifs de ce champ en

fonction de son utilisation ultérieure.

Gestion des champs attributaires
1 - Rendre la table éditable

P caractéres
spéciaux

2 — Ajouter
un champ

4 — Propriétés
du champ

-longueur de texte, du nombre,
-nombre de décimales...

3 — Type de champ

basmiry v ity
. Siune longueur de champ est [l e

e SR ]
g trop courte, la valeur du champ e o Feaiva e g
sera tronquée! =0

Nom du champ < s . R
Sans espace ni texte’ pour des raisons d’analyse

Le Type : une variable ‘nombre’
peut étre qualitative, donc créée en

@ (ex. : codes INSEE/numéros de
départements...), alors que d’autres
seront utilisés en ‘nombre décimal’
pour la symbologie (surface) ou
‘nombre entier’ (population...).
La Longueur de champ : longueur
de 50 inutile pour les données
cadrées (INSEE, surface...), par
contre pour des noms de communes,
cela semble plus indiqué.
La précision sera fonction de la
donnée. Une surface théorique
calculée avec le SIG n’implique pas

Renommer / supprimer un champ

8 chiffres apres la virgule !

La modification de la structure de la table attributaire d’une couche est a éviter : I’ajout ou le
retrait de champs peut altérer la table. Il est donc important de vérifier les données

attributaires apres ce type d’intervention.

L’onglet I"-.I' e i e l-l:ic_'i'l'ﬂ"l-fl-'_- —_ = m
Champs des oy - 0 g i M T - S B e R =l
Propriétés e

de la couche 1 O <

(cf. fiche B e | Cemaeon | Rk | Tom i | Teeslebis | e | B
B02) offre g |l Framry e, i

aussi la Ty [ T " - ,

possibilité s Mgkl 1 i | e s wm .
d’insérer / S T T s v i o
supprimer

un champ. S B A o L |

— Il est possible de renommer un champ depuis cet onglet en double-cliquant sur son nom,

&)

" toujours lorsque le mode édition est activé.

Outils complémentaires

~ Des outils de gestion des champs sont disponibles au

b Ajouter un champ a la table des attributs
# Ajouter un champ auto-incréments

& Ajouter un champ dindex de valeur unique
# Cakulatrice de champ

travers de la boite a outil de géotraitement. Activez la # Cakulatrice de champ avancée Pythan

boite a outils depuis le menu Traitements >Boite a
outils : ¥ Boite doutls | Dans I’arborescence, déplier

Géotraitements QGIS, puis Outils de table
d’un vecteur pour bénéficier des outils ci-
contre.

"@m Exporter/ajouter des colonnes de géométrie
E5| Liste les valeurs uniques
& Number of unigue values in dasses
# Refactoriser les champs
E Statistigues basiques pour les champs de texte
if Statistiques basigues pour les champs numériques
# Statistigues par catégories
# Supprimer la colonne 14
Z Texte vers décimal

41



OGIS_C04 - Création d’objets graphiques

La couche sur laquelle vous voulez créer des entités doit étre présente sur la vue (soit par
ajout de couche -fiche BO1- soit par création d’une nouvelle couche -fiche C01-).
Rendez la couche éditable (fiche C02) si elle ne I’est pas.

¢ 3Numérisation d’une entité
Attention ! A partir de maintenant, pour utiliser les outils d’édition sur la couche éditable, la
couche concernée doit étre active (surlignée en gris).
Utilisez la barre d’outils Editer /Créer des entités pour ajouter des entités. Selon le type
d’entité de la couche, 1’outil Créer est différent :

Créer un polygone

Capturer la ligne

Créer un point

Sélectionnez I’outil, puis cliquez ( 'un simple clic gauche par nceud ou point) ; pour terminer
une construction (ligne ou polygone), faites un clic-droit ( !le clic droit ne créé pas de nceud
supplémentaire).
A la fin de la construction, une boite de dialogue apparait automatiquement pour vous
permettre de renseigner les attributs de I’entité fraichement créée :
- . .
Cliquez sur OK pour confirmer la création, ou sur
Annuler pour supprimer la construction si besoin.
Cette fenétre est activée automatiquement a chaque
O entité créée ; pour la désactiver, allez dans le menu
Préférences> Options, puis, sous ’onglet

- LT

PR, i PN . A
Numérisation, cochez Supprimer les fenétres

owa gL d’avertissement...

g e Ll

= Lo e o i

PR L L) > . i Ol i 0 ] 0 O b I O e el

i e

NB. : Pour créer des entités parfaitement synchrones (limite commune, nceuds communs...)
reportez-vous a la topologie de la fiche CO5.

Lorsque vous avez terminé la création de vos entités, choisissez de Terminer I’édition (fiche
C02) et sauvegarder le travail.

(,;.QSuppression d’une entité
L’opération consiste a sélectionner une entité sur la couche et a la supprimer. Une fois qu’elle
est sélectionnée avec la fleche de sélection 4 de la barre d’outils Couche, appuyez sur

I’outil “& pour la supprimer (fiche A3 si besoin). La couche doit étre modifiable.
Pour supprimer plusieurs enregistrements, utilisez ctrl pendant la sélection.

15

OGIS_C05 - Modification d’objets graphiques

La modification d’un objet d’une couche requiert que la couche soit modifiable (fiche C02).
Quittez I’éditeur, en enregistrant les modifications une fois le travail fini !

(—9Modification
Les outils de modification sont disponibles depuis les barres d’outils Editer (fiche A03).
Vous pouvez librement créer des entités (fiche C04), déplacer une entité Cﬁ, couper lﬁ‘g, copier
El, coller Zlou supprimer “&.
Remodelez les entités /% selon une construction voulue.

D’autres outils de modification sont disponibles, depuis le menue Vue >Barres d’outils
>Numérisation avancée :

Rl 3 # &= @ o Em o G T g O
ﬁ o W "‘a JEI' % F "", l-,;]l Z-:i] C'_'h o rﬁ'ﬂ mm

L — . . E - = — _ T It

Vous retrouverez respectivement : la numérisation avancée (aide a la numérisation), activer le
tracé, pivoter, simplifier (généraliser), ajouter un anneau, ajouter une partie, remplir I’anneau,
supprimer un anneau, supprimer une partie, remodeler, décaler en XY, séparer les entités et les
parties, fusionner des entités, fusionner des attributs, rotation de symboles de points.

Les entités doivent étre préalablement sélectionnées — fiche D02 si besoin.

Neeuds A
L’outil de nceud & permet de déplacer les noeuds. Un premier clic sur le noeud fait ¢ ‘v
apparaitre tous les nceuds de I’entité (en rouge). Un clic sur un nceud le fait apparaitre en

a

blew B, un clic-glissé le déplace. Un clic sur un segment sélectionne les deux . —g—— 7

nceuds d’extrémité (en bleu) ; un clic-glissé déplace ce segment. Fow F e
QTopologie o
A partir du menu Préférences> Options d’accrochage ; vous |'_"" N v =
pouvez afficher I’environnement de capture : PR Tl SR AL 5
— I’accrochage est disponible pour la couche actuelle, certaines ou L - b
#toutes les couches ouvertes. Choisissez la Tolérance
d’accrochage (distance minimum ou la souris « glissera I

automatiquement vers un sommet ou un segment existant —
mettre 20 pixels pour vous donner un apercu). Lors de la saisie d’une nouvelle entité (en rouge
lors de 1’édition), a I’approche d’une entité existante pour laquelle 1’accrochage est activé, la
nouvelle entité vient se coller en fonction de la tolérance d’approche/ d’accrochage. Les nceuds
superposés sont alors strictement au méme emplacement !

¢9Regles topologiques — L 1 . S—
Fixer les régles de superpositions. ,h'_": - VS, # | e

Le menu Vecteur > Vérificateur de BR S g airaran i P [0~
topologie ouvre le Panneau | # . 57 o7 B Tk e s
vérificateur de topologie. BT R et i 80 s B e :

Exemple : empécher la superposition entre ME ot P
polygones : | By
) proraeny - -

1 — Depuis le panneau, appuyer sur = u —— —

N g L N I_,cll-'lu-- v ded by B b p O Kl
parametres = puis ajouter la régle : « Ne o 2 !
doit pas se superposer » pour la couche "l ol
concernée. Créer ensuite un polygone qui se sl i |
superpose a un autre. ) I REZNRI) iR i
2 - Dans le panneau, cliquer sur Valide: L
3 — Les erreurs de topologie s’affichent en = e s T
rouge dans la vue et dans le panneau i R il YN TR
vérificateur.

L’extension Vérificateur de géométrie (cf. fiche A0OS) apporte quelques outils supplémentaires.

16

42



OGIS_C06 - Modification d’objets sémantiques

—La modification des données attributaires se fait en concordance avec les objets graphiques
— correspondants. Lors d’une modification (ou d’une création) des données attributaires, il faut

L=

La sélection de 1’objet sur la carte se matérialise par un jaune fluo
les Propriétés du projet, onglet Général). Dans la table correspondante, la sélection se
remarque en gris foncé (-1). La sélection de 1’objet entraine la sélection de la ligne dans la
table, et inversement.

Calcul d’un champ
Pour mettre une table attributaire a jour, Basculer en mode édition (cf. fiche C02 si besoin),
Ouvrir la table d’attributs E=| (fiche BO3 si besoin) puis changer les données en cliquant sur
un enregistrement & modifier. Lorsque vous avez fini, Terminez I’édition.

sélectionner ’entité sur la carte pour savoir a quelle ligne de la table correspond cette entité.

(couleur modifiable dans

Pour calculer des données d’une colonne entiere (champ) vous devez dans sélectionner 1’outil
Calculatrice de champ 3 depuis les outils de la table attributaire (fiche BO3 si besoin). Une
boite de dialogue apparait ou vous pouvez calculer les champs selon une expression.

< aSi des lignes sont sélectionnées, la case permettant de ne mettre a jour que la sélection sera
~ cochée par défaut !

Calcul de champ attributaire/ colonne

Création d’objets graphiques

a T écran sur la couche éditable

1 — Choix de la colonne a mettre a jour, ou choix
La numérisation des objets se fait / de création d’une nouvelle colonne

2 - Calcul uniquement pour la
sélection ou toute le entités

Fonctions
de calculs
Tapez et champs
I'expression
ici

i Aide aux fonctions
'
3 - Calcul du champ B |

= = = -

ou =i

-~ Calcul des coordonnées X et Y
;’Choisissez Géométrie> $x pour les coordonnées X, et Géométrie> $y pour les coordonnées Y.

Exemple : Pour calculer I'aire, appuyez sur Géométrie> $Area, il apparait dans la zone de calcul (valable pour
des polygones — longueur est actif pour des lignes). Les
I’expression pour les chaines de caracteres (texte).

(guillemets simples) sont nécessaires dans

Le calcul des coordonnées X et Y dans QGIS avec création d’une nouvelle couche.

A) A partir du menu Vecteur > Outils de géométrie> Exporter/ Ajouter des colonnes de géométrie.

B) A partir du menu Vecteur > Outils d’analyse> Coordonnées Moyennes, une boite de dialogue
apparait ; choisissez : (1) la couche (pour laquelle vous voulez les coordonnées des entités), (2) la
colonne (qui contient un identifiant unique par entité — donc par ligne), (3) le chemin

d’enregistrement (de la nouvelle couche ainsi créée).

NB. : Si vous ne disposez pas d’une colonne comportant un identifiant unique par entité, vous pouvez en calculer
une depuis la calculatrice de champ, en cliquant sur le bouton rownum (calculant ainsi, dans le champ désiré,
pour chaque ligne le numéro de ligne !)

17

OGIS D - Analyse spatiale

L’analyse spatiale participe au traitement méme des données a partir de requétes spatiales
bien définies ou d’actions qui permettent de répondre a un questionnement précis.

Une requéte est une opération qui consiste a interroger une partie de la table de données (ou
table attributaire).

Les requétes peuvent porter aussi bien sur des données attributaires que sur des objets
géographiques.

Liste des fiches :

QGIS_DO01 - Sélection par attributs (requéte attributaire)
QGIS_DO02 - Sélection géographique (requéte géographique)
QGIS_DO03 - Jointure attributaire/ Jointure spatiale
QGIS_D04 - Outils d’analyse spatiale : vecteur

QGIS_DO05 - Outils d’analyse spatiale : raster

18
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OGIS D01 - Sélection par attributs (requéte attributaire) Tant que le filtre reste actif, le logiciel ne considérera que les entités filtrées !

La sélection attributaire se fait sur une seule couche et sur un ou plusieurs attributs de cette
couche (attention, ceci concerne donc la couche active / surlignée en gris) :

» Sélection

~ La sélection par expression est accessible depuis la table attributaire (fiche BO3 si TR
besoin) ou de la barre d’outils Couche (fiche A03 si besoin) en cliquant sur le :;:1:_15-‘5. !
bouton & Attention : avec cette Sélection, on observe le résultat de la sélection B
en surbrillance jaune fluo, mais les autres entités sont toujours présentes. Dans ce iﬁf_‘s -
cas, vous pouvez désélectionnez les entités sélectionnées de la couche active avec
I’outil Effacer la sélection “@ de la barre d’outils Couche.

g Sélection par attributs La couche concernée par la sélection
- Opérateurs est la couche ACTIVE
/ de sélection Aide
Requéte finale "»---'-J:w LI BT L (B contextuelle

B fymppries

-

Choix des
Champs
etdes
fonctions
‘ Choix des
- P b i ot | i = Valeurs
e, i A connues
4 : Vérification :

_

5 : Méthode de sélection

Les valeurs en texte sont a saisir entre guillemets simples ('..."), contrairement aux nombres.

And :"vrai" lorsque ses deux arguments (les expressions qu'il relie) sont vrais. Un enregistrement doit donc satisfaire ces deux conditions
pour étre sélectionné.

Or :"vrai" lorsque l'un au moins de ses arguments (les expressions qu'il relie) ou les deux sont vrais. Un enregistrement ne doit donc
satisfaire qu'une seule de ces deux conditions pour étre sélectionné. Il est aussi sélectionné s'il répond aux deux conditions.

Exemple

Sélectionner les départements qui ont leur chef-lieu dont le X est 2 moins de 5100m de I’origine (attribut « X ») et n’appartenant pas a la
Bretagne (attribut « NOM_REGION ») dans la couche ‘deparement.shp’ :

Couche : DEPARTEMENT.SHP (a activer en gras dans la vue)

Criteres (requéte) : X <= 5097 AND NOM_REGION != "BRETAGNE'

X et NOM_REGION (noms des colonnes) sont a sélectionner dans le menu champs, <=, = et AND dans les Opérateurs. 5097 et
'BRETAGNE' peuvent étre saisis directement dans Valeurs connues.

— Exporter la sélection
- Vérifiez que la couche sur laquelle vous venez de réaliser la sélection soit bien active (en
gras), puis choisissez le menu Couche> Enregistrer sous... (ou par clic-droit sur le nom de
la couche> Enregistrer sous...). Sélectionnez «N’enregistrer que les entités
sélectionnées ». Déterminez le nom de la couche de sortie (le type de fichier et la projection

si besoin).
Q;)Filtre
Depuis la vue, choisissez le menu Couche ou par clic-droit sur le nom de la couche, B o
choisissez Filtrer. Entrez 1’expression de sélection ; seuls les objets correspondants a la :".-"F? T
requéte apparaissent a I’écran; il est possible d’effacer la sélection a partir du &
@Constructeur de requéte (filtre) : laisser la partie requéte (Expression de filtrage) i
vide. ¥ )
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OGIS_DQ02 - Sélection géographique (requéte géographique)

Sélection manuelle

= 1=
Les outils de sélection géographique sont disponibles par la fleche noire a droite de I’outil ‘

(Sélectionner) de la barre d’outils Attributs (fiche A03), ou depuis le menu Vue> Sélection de la

fenétre Vue.

Une liste de sélections s’offre a vous pour la couche ACTIVE (en

gras) :
A Taide de 1’outil

Bk (ou autre type de sélection), cliquez sur |,.

I’entité que vous voulez sélectionner (plusieurs sélections en
maintenant Ctrl). L’entité sélectionnée apparait en jaune.

¢ 3Sélection par localisation
Le menu Vecteur> Outils de recherche, offre plusieurs sélections, comme des sélections aléatoires...

La sélection la plus utilisée
est la Sélection par
localisation :

Elle sélectionne des entités
d’une couche en fonction
d’entités d’une autre

couche. La syntaxe se monte comme une simple

11 St Tisigial

i e . il o, @

T e e v

SO TR T LR W

bz o P oo gnde -
Sl ot o D B s

Db oy o ey e i,
B il L UL

e T AR L I

*F.

Tl =,

.- .:I. . II L‘
.|.:'| | :l-'lh_ﬂi

phrase a lire. Désélectionnez les entités

sélectionnées de la couche active avec I’outil ~@.

Exemple ci-contre : un point rouge brille en jaune : il intersecte les

polygones.

.9 Cet outil remanié apporte la possibilité de créer
" un tampon de sélection (dans le systeme de

>

ammair |

P | g | Po———i

b 1 e bt

m,H::'r-;::,-_Couche de points. - -

miho ey Lsach i

=== Couche de pelygones

S pann

projection de la « couche supplémentaire ») et permet de générer la sélection sur des couches non

chargées dans QGIS.

@Outils supplémentaires de sélection géographique

.B .

Opérateurs de la requéte spatiale

Intersecte

Contient Pintérieur
B
Croise
B
Est disjoint Est égal
A

B

L

A est la couche de référence, B est la couche dans laquelle on sélectionne

Chevauche

Touche

+

Exemple :

Sélectionner les éléments de la couche ‘riviere.shp’, qui intersectent le département du Nord

de la couche ‘departement.shp’ :

Vous devez, dans un premier temps sélectionner, le département du Nord dans la couche

‘departement.shp’ (A) (A 1’aide d’une sélection simple fiche DO1).

Dans Iinterface de requéte spatiale (cf. ci-contre), Vous devez choisir la couche ‘riviere.shp’
(B), puis la couche ‘departement.shp’ (A) (seule la sélection préalable sera prise en compte
dans I’opération si vous cochez ‘I selected geometries’).
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D’autres outils sont disponibles
au travers du menu Vecteur>
Requéte spatiale comme le

montre 1’encadré

ci-contre.

Cette extension est installée par

défaut et désormais
la désactiver
Extension de

(pour
décocher

activée
il faut

requéte spatiale dans le menu

Extension>
d’extensions).

it et

Al e ek B

=ma -

anin
Rl i=
ralomiem
[ R

Gestionnaire

" Fe0s lignes et points

A llinkerieur

Croise
Disjoint
Intersecte
Touche

polygones

A linkérieur

Chevauche
Contient
Disjoint

Ect &gal
Intersacte
Touche

21

OGIS_DO03 - Jointure attributaire/ Jointure spatiale

iy Jointure attributaire
La jointure de tables est généralement utilisée pour adjoindre des attributs supplémentaires a
la table d’une couche géographique (couche de départ). Pour joindre deux tables, le type des
données du champ joint doit étre identique entre les tables (nombres, chaines...).

Faites un clic droit sur le nom de la couche a laquelle vous voulez associer des données
supplémentaires, choisissez Propriétés, puis I’onglet Jointure Q. Pour ajouter une nouvelle
.. . gk . 7 ..

jointure, cliquez sur le bouton @, puis paramétrez la jointure :

ointure attributaire

AL T = 1: Couche jointe

e

Renseignez la couche ou
/ Possibilité de joindre une

table a joindre a la couche
ciblée, puis le champ de
jointure pour cette table
attributaire. Entrez ensuite
le champ de jointure de la
couche d’origine (!! Un
champ de jointure peut
porter un nom différent
dans les tables).

Ce sont les attributs de la
table jointe qui viendront
se greffer sur ceux de la
ot table de départ.

2 : Champ de jointure

De la couche jointe

simple table attributaire (DBF)|

de jointure
de méme
nature!

(texte,
ombre...

3 : Champ de

jointure
De la couche d’origine

11 est possible de modifier une jointure préalablement réalisée

Il est possible de sélectionner seulement les champs utiles de la table jointe, et de leur
appliquer un préfixe pour les identifier, en cochant les cases correspondantes.

@Lorsqu’il n’y a pas de correspondance de champ pour la table d’origine, des valeurs nulles
seront attribuées aux champs joints :
Chapps de la couche de départ Champs de la couche jointe

[T
"5 LT
) e,

[ETaT g

[ SR

R

Exemple :

Vous disposez d’une couche ‘comm.shp’ représentant le contour des communes ; la table attributaire de cette couche ne contient que le code
INSEE de chaque commune (nommé IDINSEE). Vous disposez, d’autre part, d’une table attributaire ‘comm_attr’ (sans données graphiques)
contenant le nombre d’habitants (attribut « hab ») et d’autres champs pour chaque code INSEE ; ce dernier s’intitule CODE dans la table.

1. Joindre la couche comm_attr ; 2. Joindre le champ : CODE ; 3. Champ ciblé : IDINSEE

- Jointure spatiale
~ Pour opérer une jointure spatiale (selon I’emplacement et la superposition |
des objets) ouvrez Joindre les attributs par localisation du menu Vecteur> | =
Outils de gestion de données. Dans la boite de dialogue, sélectionnez |
d’abord la Couche d’entrée (1) qui contiendra les objets du Fichier de |« -

sortie (3), puis la Couche a joindre (2) qui contiendra les attributs joints. = &)
Vous pouvez faire un résumé statistique des données numériques jointes, et [ —
conserver toutes les entités de la couche de départ ou seulement celles qui

ont une correspondance avec la couche jointe(4).
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OGIS _DO04 - Outils d’analyse spatiale : vecteur OGIS_DO05 - Outils d’analyse spatiale : raster

i”i Les outils d’analyse rasters sont centrés sur 1’analyse du maillage du territoire (ceci est 1ié a la

gLes outils d’analyse sont nombreux, il convient de réfléchir a la finalité du travail avant de se nature du raster) ; il convient de réfléchir a la finalité du travail et de connaitre les dites

lancer dans les modifications. Les outils d’analyses sont dans le menu Vecteur> Outils de analyses avant de se lancer dans les analyses. Les outils d’analyses sont dans le menu Raster.
géotraitement : P —
by b S R Chaque outil est composé d’une interface ot il faut renseigner deux Calculatrice raster - -
i DffEsenciation symétriqus ou trois €léments. Exemple de I'intersection : Le menu Raster > Calculatrice Raster lance un il L
7 Ditance tampon varsbls 1. Coucheenentrée Couche sur laquelle I’opérateur va agir. outil trés puissant qui permet de paramétrer des i e
P unicn 2. Couche dintersection Couche qui participe a I"opération. opérations et croiser des rasters. s — o
3. Intersection Couche résultante de 1’opération ‘]
# Desolz P Exemple : au Kenya, la relation entre I’évaporation annuelle moyenne (Eo) et -y - = s =
i T’altitude est la suivante (Studies of evaporation in Kenya, EAAFRO, Nairobi, 1 = - .
By’ Dfference — L’opération se réalise sur des couches ouvertes ou non dans 1968) : Eq (mm) = 2422 — (0.109 x altitude (pieds)) " Y T
P Dctance campon fie ‘;‘:’J QGIS. Selon loutil des OpthIlS de parametrages En d_isllaosamldu raster MNT nomn/1é MNTTI,O(.)M@I de la zone considérée, il L
] ~ . . est aisé de créer le raster des températures a I’aide de la Calculatrice Raster, en g =
™' Coupar supplémentaires peuvent étre disponibles. inscrivant I'expression de la calcultatrice raster comme suit :
g Susgnmer les débordements @ Si vous avez une sélection active sur une des couches qui entre 2422-(0.019 * "MNT_l00OM@1")
@ Envelonpe convexe dans I’analyse, I’opérateur réalise 1’analyse uniquement sur e =,
celle-ci ! g Analyse d’altitude / élévation
Droinga Les rasters d’altitude (MNT : modéle numérique de terrain),
Retrouvez ci-dessous quelques exemples d’outils les utilisés en SIG, présents dans QGIS : T permettent de déterminer directement (par dérivée) la pente,
o A . Sk £ ol I’exposition, I’ombrage... d’un terrain.
Exemples d’outils d’analyse (Menu Vecteur> Outils de géotraitement>) T A L] . . . .
e opr \rees i P emameanaua | €S outils sont disponibles depuis le menu Raster > Analyse de
Distance tampon fixe(s) Différence Ruiges e terrain et Raster > Analyse > MNT/DEM.

Toutes ces analyses nécessitent un MNT au format raster en entrée.
k@ - @ { i Les MNT déterminent les points les plus hauts, les plus bas, les sens d’écoulements donc
| indirectement les bassins versants. L’analyse poussée des MNT est possible au travers du

.............. R — plugin GRASS et de ses traitements disponibles depuis le menu Traitement > Boite a outils.
Couper Union
i. s = e | | _: z Distance mvers= & une puissance| L’ interpolation permet de générer une donnée continue en raster, a partir
I =* | a = e — e Moyenne mobile d’une donnée de relevés ponctuels sur le territoire (température, altitude,
: T st 1= Métrique des données
e gAccesmbles depuis le menu Raster > Analyse > Interpolation ou Raster > Interpolation,

pour assembler les entités qui se superposent Interpolation automatique
Plus proche voisin . ..
précipitation...).

Intersection Dissolve algorithmes d’interpolation proposés par QGIS, présentés ci-contre. D’autres méthodes telles
pour assembler uniquement les portions d’entités qui | Fusionne des entités selon une colonne spécifiée que le Sphne / kfigeage sont accessibles au travers de GRASS / SAGA deplliS le menu
se superposent ou a limite commune Traitement > Boite a outils.

n : 1
4 e I;.-' ) = ﬁzj& el Lf- J @ Le choix de la méthode dépend du type de données et de la distribution spatiale des points.
X ) -y Exemple de trois interpolations :

L'interpolation IDW (Inverse distance weighted) détermine la
valeur des cellules en calculant une moyenne pondérée a partir des
valeurs des points du voisinage. Il est impossible de créer des crétes
ou vallées si les valeurs nécessaires ne sont pas présentes dans la
donnée de départ. Si les données d'entrée sont clairsemées ou
inégales, le résultat obtenu ne sera pas vraiment représentatif.

La méthode d'interpolation Spline consiste a faire passer une ligne
par les points de voisinage tout en minimisant la courbure de la
surface. Le voisinage est défini par les points les plus proches.

Les outils d’analyse et des outils supplémentaires sont intégrés dans QGIS au travers de la
Boite a outils de traitements.

Activez la boite, depuis le menu Traitements >Boite 2 outils: @ Bcitedoutls . Dans
I’arborescence, déplier pour bénéficier des outils. Activez L’extension si nécessaire (fiche

AOS) Cette méthode est adaptée aux surfaces sur lesquelles les variations

Géotraitements QGIS> sont peu importantes. La méthode Spline peut donner des résultats

GDAL/OGR> Outils d’analyse vectorielle Géotraitements QGIS> Outils incorrects lorsque les variations sont importantes sur une distance

[OGR] Géotraitement W e de recouvrement de vecteur(s) horizontale courte car elle peut se traduire par une surestimation ou

- L une sous-estimation de la valeur.

T o ey b g e e PR Coonchar e ooircs com bar podvgomes Ll Le kri \ “tre méthode 2 prend idézation

B oo far e sk polgan " D i e N g B e AT e e VR e e © krigeage 65[.apremler‘? méthode a prendre en consideration la

e A R A i LB AR Lo o ™ O TR . corre!auon spatlgle (appréciation gmph’lque de l’aA val:lance en

e R T— & ik i T nal L, el - E. [P PP -l Lo | ; fm’lcuon de lal dl'slan.ce entre les données). L'intérét qune telle

_:. | . 15 Fabwnr pplin e o N 5 Bttt m = KRIGEAGE m?ith.od-e est l'estimation des valeurs et le calcul de l'erreur de
ol TRl o ol i i (0 Ko B iy e o - Do s e ool gorss [nmsidon . sand IS A p— prédiction.

W e o ey e P e LR b T T g (e . iy T
F. Guerreiro ?ru—_."-::::rum 23 F. Guerreiro 24

Mise a jour : déc. 2016 — cc by-nc-nd 2.0 Mise a jour : déc. 2016 — cc by-nc-nd 2.0
e o B o s b e B



OGIS E - Analyse thématique/Sémiologie/Symbologie

@L’analyse thématique met en évidence un ou plusieurs phénomenes de la carte et participe

grandement au rendu final d’une carte. Elle joue un rdle dans la perception de la carte par vos
interlocuteurs. Il est donc indispensable de prendre du recul pour voir si le rendu de
I’information est fidele a ce que vous vouliez mettre en avant. Il est aussi indispensable que
votre information soit claire et non noyée dans une masse d’informations inutiles.

Liste des fiches :

QGIS_EO01 - Symbologie/ Affichage simple des entités
QGIS_E02 - Analyse thématique/ Affichage avancé des entités

QGIS_E03 - Etiquetage des entités
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OGIS_E01 - Symbologie/ Affichage simple des entités

gModiﬁer toutes les entités d’une couche
- Cette étape est importante lors de la manipulation des données, car elle gere le rendu visuel de la
superposition des couches. C’est dans ces propriétés que vous rendrez I'intérieur des entités d’une

couche transparent pour voir les couches du dessous.

Double-cliquez sur la couche ou faites un clic-droit pour afficher les Propriétés de la couche (fiche
BO02 si besoin — propriétés d’une couche), puis sélectionnez 1’onglet Style (1).

Assurez-vous que le premier bouton de 1’onglet soit sur affichage simple / Symbole unique (2).

Quel que soit le type d’entité (point ligne ou polygone), vous pouvez modifier le fond et la couleur des
symboles, a 1’aide de la partie Couches de symboles (3).

Changer le figuré unique de toutes les entités de la couche

‘ #% Rendu final
(2) Symbole unique endu fina

Transparence

Couleur

= i e 1

e b et~ OPLiONS

L o -
Sl - Amp— liées au L
. e type d’entité: ‘= =

(exemple
pour les
points)

gjLe type d’options est fonction du type d’entités (polygones/ multipolygones, lignes/ polylignes, points/
=¥ multipoints) o

Le Gestionnaire de symboles du bouton %3 ##58 hormet de changer plus d’options dans
I’affichage des entités de la couche, et de créer vos propres symboles.

La transparence générale de 1a couche se gere a I’aide d’une barre . s o
de progression présente en bas de la boite de dialogue, mais  wcprum it

chaque élément de symbole possede sa propre variation de

transparence si besoin.

En bas de la boite de dialogue, il est possible d’agir sur le Mode de fusion des couches,
(éclaircissement / assombrissement), pour un meilleur rendu graphique.

Si un champ de la table attributaire contient les valeurs nécessaires a la
caractérisation de la symbologie des entités (couleur de fond, largeur de

bordure...), il est possible de 1’appliquer en cliquant sur le symbole = situé
a c6té de I’option concernée. -

ak

o Caxrdan

wL’ouverture répétée des propriétés de la couche pour « tester »

— différents affichages de la couche peut désormais s’éviter en O T i
appuyant sur le bouton ouvrir le panneau de style de couche T it
présent au-dessus de 1’arborescence des couches qui ouvre un e
panneau de mise a jour en direct.
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OGIS_E02 - Analyse thématique/ Affichage avancé des entités

@L’analyse thématique a pour objectif principal de mettre en forme les données que vous voulez
afficher sur une carte. Elle répond aux régles principales de la sémiologie graphique. Reportez-vous a
ces reégles pour connaitre les différents types d’analyses et/ou méthodes de classification des données.

Représentations selon les types de données
QDans les Propriétés de la couche, sélectionnez I’onglet Style.
Dans la partie supérieure de la boite de dialogue, sélectionnez I’analyse thématique
(Type de légende) la plus appropriée a I’affichage de vos données. Reportez-vous
a I’aide et aux regles de la sémiologie graphique pour adapter votre analyse.
Utilisez I’affichage Catégorisé sur une palette de couleurs distinctes (!) pour les
valeurs qualitatives et Gradué pour les valeurs quantitatives ordonnées (variables
continues vers des variables discretes). Les valeurs quantitatives absolues (variables brutes absolues)
seront représentées par un affichage de symboles proportionnels sur leur centroide.
- Carte de chaleur : représenter une densité de points sous forme de raster.
- Ensemble de regles : combiner les regles de représentation.
- Déplacement de points : déplacer 1égerement les points qui se superposent.
- Polygones inversés : appliquer une symbologie a 1’espace non occupé par des polygones.
A - Aucun symbole : Aucun symbole ne sera affiché pour la couche.
¥ . [ edencrass : Utilisation de la symbologie Grass.

Valeurs quantitatives ordonnées

(1) Pt e | md s el =] (2)
= i : Type d’analyse

Champ de e e
classement - | thématique
2 . JoETTeT R ;
(4) S \ ?;1?.”“-:-\,-\..
Couleur de e
classement 6)
Q)] Etiquette de
Classement légende et
des valeurs g (3)  précision
Importation de .« -| Nombre de
la symbologie ™ classes
Aprés un changement de type d’analyse, il est impératif d’appuyer sur le bouton | @

Vous avez aussi la possibilité de rentrer vos classes manuellement (5).
Remarque : Les couches sont enregistrées en shapefile (*.shp). Les symbologies produites avec Sauvegarder le style sont en *.qml.

@La classification de données quantitatives n’est pas le fruit du hasard ! L’histogramme de répartition
des données offre la visualisation de la fréquence de distribution d’un champ donné avant d’entamer
une classification des données. Les régles générales sont les suivantes :
/|- Symétrique : Méthode de la moyenne et de I’écart-type
, - Dissymétrique : Effectifs égaux (quantiles) ou ruptures naturelles
| |- Uniforme : Amplitude égale (Intervalles égaux)

QL’histogramme est disponible depuis I’onglet g 196 | i i ¥
Histogramme, en milieu de fenétre, en t: 3 L
complément de I’onglet Classes (5). Une ‘2l |
classification (méme manuelle) doit étre justifiée. | e e w = BN =
Exemple )it L e T .,

Pour représenter la densité de population d’une couche de polygones :

Dans la partie haute de I'onglet Style, sélectionnez Gradué puis Intervalles égaux (ou autre mode de calcul des classes selon répartition de
I’histogramme !). Dans la partie Colonne, au centre de la boite de dialogue, choisissez le champ DENSITE, puis le nombre de classes. Vous
pouvez changer les couleurs des plages ainsi que la légende qui apparaitra dans la partie droite de la boite de dialogue.
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OGIS_EO03 — Etiquetage des entités

gDans les propriétés de la couche (fiche BO2 si besoin — propriétés d’une couche) sélectionnez
I’onglet Etiquettes (ou menu Couche> Etiquetage).
Assurez-vous que 1’étiquetage
des entités est actif en | i Montrer les &tiguettes pour cette couche -
sélectionnant en premier lieu
« Monter les étiquettes de cette couche :

Assurez-vous que le champ Etiquette avec est bien celui qui contient les étiquettes que vous
voulez voir afficher !

L’étiquetage se paramétre en premier lieu par le Champ de I’étiquette (apparait sur la carte
finale), la Taille de police, la Police,\ la Hauteur et la Couleur.

La mise en page de
I’étiquette (retour a la
ligne...)

I L . =

meneCam (1) Champ pour I'étiquetage  +

F . e D rreepde el peew | erpes

La création d’un halo
autour de I’étiquette

Wl

(ombrage). T

B EE

Création d’un fond . — 4

d’étiquette et décalage fein] 0y i L

de 1’étiquette pour . i LB

éviter les rm Ll <

chevauchements. H HE
g | " e - |

Le placement de pases :"""' - 3 : »

I’étiquette par rapport
a I’entité.

i

:

i
Frk
|

;
e

Les niveaux de zoom
pour lesquels les
étiquettes seront

visibles. =L B
De plus, le bouton | = |, en haut de la fenétre permet de paramétrer ces options en fonctions
d’autres champs de la table attributaire.
Style -

Enfin, il est possible d’enregistrer les parametres de 1’étiquetage :

Si un champ de la table attributaire contient les valeurs nécessaires ala | __
caractérisation d’un élément de représentation du texte (couleur de | =™

fond, espacement des caracteres...), il est possible de I’appliquer en | Ttk
cliquant sur le symbole G situé a coté de I’option concernée. B ——
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0OGIS F - Mise en page

aLa mise en page est I’étape finale du travail. Les étapes de manipulation des données

- (création, analyse spatiale), et de représentation de la symbologie, doivent étre terminées pour
entamer la mise en page.
Elle consiste a mettre tous les éléments indispensables a une carte.
La carte doit contenir impérativement :
Une légende, un titre, I’orientation, 1’échelle, les sources, le nom et la date de réalisation.

Les logos et mentions légales ne sont pas superflus, ainsi qu’un texte explicatif pour éviter
toute mauvaise interprétation de la carte produite.

Liste des fiches :

QGIS_F01 - Création d’une mise en page
QGIS_F02 - Création d’une légende
QGIS_Fo03 - Eléments d’une mise en page

QGIS_F04 - Exportation de la mise en page

30
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OGIS_FO0I - Création d’une mise en page

La création d’une mise en page permet d’éditer une carte compléte pour I'imprimer ou

I’exporter.

Avant de lancer une mise en page cartographique, assurez-vous d’avoir adapté la symbologie
et les étiquettes de vos couches dans les propriétés de chaque couche (fiches E).

QLanceZ une mise en page a partir du menu Projet> Nouveau composeur d’impression :

Composeur de carte

“#® A partir de la fenétre du
composeur, adaptez la page
(soit depuis le menu
= Composeur> Parameétres
de la page, soit a partir de
I’onglet Composition, a
droite du composeur) et
= | changez la mise en page de
- i 2 paysage (horizontal) vers
et i | portrait (vertical) si besoin.
s Lal " | Vous pouvez vous déplacer
= 2 sur la page a partir de la
| | barre spécifique et du menu
- Vue :

i
-
1

]

]
S
G

Le menu Mise en page permet d’ajouter et d’organiser les éléments de la lise en page :

; 4omied e Lo
5 PR T T
= i e ik reebon
B - irw by
e Ery
roi Hhiae
1 A e P

T, S e e

S A
L Dt gl 5
¢ e Cpedos 1
Crpe s FaiEr
¢ Moo v
il La e
S L=
I T iEET Cricka.t
Bl v P d g Wi
T i e ol ke Beeds. Tl
e o L

Les éléments ajoutés depuis ce menu sont des Objets.

Le cceur de carte, a savoir la Vue, s’ajoute en premier lieu a
partir de ce menu Mise en page> Ajouter une carte .

Pour ajouter les éléments indispensables a votre carte
comme le titre (Texte 'lﬂ), I’Orientation .=, 'Echelle &,

la Légende -2 (fiche FO2) ou un logo (Image %), allez
dans Ce menu Mise en page et sélectionnez 1’item désiré.

Lorsque la carte est terminée, allez dans le menu Fichier,
pour Exporter en image, PDF ou SVG (fiche F04).
N’oubliez pas d’Enregistrer le projet au fur et a mesure de
votre travail (fiche A04 si besoin).

Les objets ajoutés a la mise en page possedent plusieurs
options spécifiques dans 1’onglet Propriétés de I’objet, a
droite du composeur (fiche F03).

On supprime un objet sélectionné a 1’aide de la touche Suppr.

Les onglets a droite du composeur :

Composition : Mise en page générale de la page (format, résolution...)

Propriétés de I’objet : Propriétés relatives a 1’objet sélectionné sur la page.

Génération d’atlas : Générer un atlas par zones (Exple : Créer une carte par département)
Eléments : (dé)verrouiller un objet (fixer sa position), (dé)afficher les objets présents sur la

page (carte, légende...)

31

OGIS_F02 - Création d’une légende

« 3Une commande spécifique existe pour créer une 1égende décrivant toutes les informations contenues
dans la carte. Menu Mise en page> o AjoutsrunzBgends | o4 cliquer sur la mise en page pour
P’insérer. Pour cela, il faut bien évidemment se trouver sur une fenétre Composeur (fiche FO1 si

besoin).

—— 1.’ ajout d’une 1égende est totalement lié a la vue active qui lui est associée.

ol Une fois la légende ajoutée, I’onglet Propriétés de I’objet associé a cette 1égende
¥ o pepass - (partie droite du composeur), propose plusieurs sous-onglets cliquables pour
-k s paramétrer celle-ci : titre de 1égende ; ajouter/supprimer/grouper les éléments de la
I b légende, les renommer ; format général et police des €léments (titres et couches) ;
[ créer la légende en plusieurs colonnes ; changer 1’aspect : du fond ou des bordures
b e du cadre de légende...

L 2 — Mettre a jour les
1 - Propriétés de la éléments en

légende

i;! Création d’une légende

fonction des
modifications de la

carte, ou
réinitialiser toute la
-- - légende
| Legende
VI reg_sat 3 - Sélectionner
1 I’élément de

légende a

modifier
4 — Réorganiser les

éléments de légende )
9 — Créer des

filtres
d’expressions

8 — Afficher
uniquement les
couches visibles

7 — Afficher le
nombre d’entités

5 — Créer un groupe
de couches

6 — Renommer
I’élément de la couche

La légende sur la fenétre Carte est dynamique ; elle peut se mettre a jour lorsque vous modifiez les
éléments de la couche (nom, figurés...). Il est conseillé de ne créer la 1égende qu’apres avoir finalisé
tous les éléments nécessaires a la carte.

2 Libellés des éléments de légende

~ Pour gérer durablement les libellés de la légende, vous pouvez vous reporter aux Propriétés (fiche
BO02 si besoins) de la couche concernée. En effet, sous 1’onglet Général, vous pouvez modifier le nom
de la couche, C’est sous I’onglet Style des Propriétés de la couche que vous pouvez modifier les
libellés de la symbologie des éléments (Légende).

@NB. : Les éléments de la 1égende sont organisés par défaut selon 1’ordre d’empilement des couches.
Celui-ci ne correspond bien souvent pas aux regles de mise en page d’une légende (élément principal
de la carte en premier, regroupement des éléments de la 1égende en fonction de leur nature...).
Diagrammes [y

QLes diagrammes en camembert bénéficient désormais d’une légende | yueninasig e

7 paramétrable. Depuis les propriétés de la couche, puis 1’onglet Diagrammes, |® wromcegeeyet

vous disposez du sous onglet Légende, qui offre la possibilité d’afficher : — e
- Les éléments qui composent le camembert L
. e . L1
- La variation de taille des | # = o putor ot
diagrammes 5%
] v i
iy
'r'_ :: 4y W w5 R e e U da peer
08 Dol e L L e S S Y TSy p—
i 32
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OGIS_F03 - Eléments d’une mise en page

< »Ajouter une carte/ vue :
La vue s’ajoute en premier lieu ‘. Depuis le composeur, vous pouvez adapter la vue (zoom
depuis la molette de la souris et déplacement depuis 1’outil q}).

La vue, appelée Carte reste paramétrable depuis 1’onglet Objet a droite du composeur :
b oot corpek Mise a jour de I’apercu et rendu en temps réel ou non (si vous modifiez la vue)

b Thpas Niveau de zoom de la carte

b | ek Bchelles de atlas

¥ Frsiade Création d’une grille de repérage sur la carte
R Créer un apergu (carte de localisation)

... Gestion du cadre de la carte, de la transparence. ..

[

Lorsque cette carte est terminée, vous pouvez Verrouiller les couches pour cette carte dans
I’onglet Propriétés de I’objet> Carte a droite du composeur.

QGérer les éléments :
i e Les éléments de la mise en page s’ajoutent a partir du menu Mise
i ::?::‘-u-.-.- en page du composeur.
Ty bt ima Lk Exemple : Ajouter du texte : titre, commentaires...
A o S Pour ajouter du texte cliquez @ puis sur la carte a I’endroit désiré.

Ll e i

Lo o Tor Vous pouvez par la suite déplacer cet objet et modifier le texte
ik ik e (taille, police, habillage, etc.) dans ’onglet Propriétés de I’objet.

e ; Dans cet onglet, des options spécifiques & chaque objet sont
e c disponibles dans les Propriétés principales. D’autres sous-onglets
i i permettent de choisir le fond, le cadre et la transparence de 1’objet.
H A i

. Ajouter une orientation :

‘E’H n’existe pas dans le composeur de QGIS d’élément d’ajout réel de fleche nord. Cependant,
vous pouvez afficher une simple fleche < , ou une image =: (plusieurs modeles de fleches
indiquant le nord sont disponibles dans les images par défaut proposées — si vous exercez une
rotation de la vue ajoutée, pensez a le faire aussi pour la fleche nord !)

(ST e
[T R =Y

/»wiAjouter une échelle graphique : T
L’échelle graphique & est paramétrable dans I’onglet Objet :
1- Choisir la carte associée et I’apparence de 1’échelle -

2- Choisir I'unité de I’échelle qui sera affichée g =
= ——
. 3- Ch0}51r'le facteur d u\mtes “

Exemple : les systémes de projection sont en metre ; =X==S
pour un affichage de I’échelle en km., il faut un facteur de 1000 u

4- Choisir la largeur d’échelle (taille des segments) —— |

~—Disposer les objets :
(= !

11 est possible de disposer les objets les uns par rapport

-l . 2, . . .
i) = ’ aux autres. Pour cela il faut sélectionner plusieurs objets
I = N . . 2 . oqe

JRE = (2 T’aide de la touche Maj enfoncée) puis utiliser les
A NI L= ] . s .

~ | outils de la barre concernée ou du menu Mise en page.
[T = R L= b . . )1/
e ek ety ChaL Vous pouvez ainsi grouper des éléments. .

Les outils classiques d’agencement des objets les uns par

$ Tl el ol Tl
rapport aux autres (avancer un élément, le reculer...).
Vous pouvez aussi aligner ces objets a 1’aide de 1’outil 5.

o

=

OGIS_F04 - Exportation de la mise en page

farmat brp {*.bp *BMPY

. ., . . . Farmat ico (*.ico, *1C0)
Lorsque la mise en page est terminée, vous avez le choix de I'imprimer  foymat jpeg ¢* jpeg. *IPEG)
ki e

(menu Composeur> Imprimer) ou d’exporter cette mise en page (menu f IPG)
Composeur > Exporter au format PDF ou Composeur > Exporter
au format SVG, ou Composgur > Exporter comme image). Format i (¥t *TIF)

Lorsque vous exportez en image, vous avez le choix entre tous les Format Giff (*.tiff. *TIFF)

formats suivants : Farmat xbr (*,xbm, *2EM)
Farmat xpra (¥, xprn, *xPM)

Avant I’export final, il est indispensable d’observer la carte en taille adaptée ;} qui donne
une visualisation globale de I'image finale qui sera exportée (ce qui inclut la taille des
étiquettes par exemple).

Exemple d’impression :

Carte o taey sirspnosion et R v e :
_:‘f‘—.‘ = 1 emarques sur 1 exemplie :
‘-uﬁ_f

.
=
1

Vous pouvez insérer plusieurs vues
différentes sur une carte (plan de situation...).
11 suffit de verrouiller les cartes déja présentes
(onglet Eléments) lorsqu’une carte est
terminée. Cependant, si une couche doit entrer
dans la composition des deux visualisations
mais avec une symbologie, étiquetage
différents, il convient alors de copier cette

N W

g . /| | couche, afin de pouvoir gérer plus facilement

—

les vues séparément.

Remarques sur le format d’export de la carte :
- L’export en PDF : L’installation d’un petit logiciel d’impression en images diverses
tel PDFCreator, disponible gratuitement sur Internet peut contrer ce probleme.
- D’une maniere générale, il est préférable d’exporter en PNG lorsque votre carte ne
contient que des vecteurs et en JPG des qu’il y a des images ou des rasters sur votre
carte.

Générer un atlas
| o b d i Depuis la fenétre de composition, aller dans le menu
Vue >Panneaux > Génération d’atlas s’il n’est pas
v | g activé.

i e -

II W A
|

R T

11 est possible de générer un atlas (batteries de cartes

A en fonction d’une couche de polygones).

| e ] Indiquez la couche qui servira de découpage et
el =|[ = paramétrez la sortie des fichiers.

[ + s . o o

Au moment de I’impression, il faut choisir un fichier

de destination au lieu de choisir un nom de fichier.

o aim m e

s e b

Exemple : Créer des cartes en fonction des limites de
départements. L’atlas génerera autant de cartes qu’il y
a de départements, sur leur emprise respective.

34
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OGIS G - Intégration de données externes

Liste des fiches :

QGIS_GO1 - Ouverture de données tabulaires (txt, csv, dbf), GPS et autres
QGIS_G02 - Géoréférencement d’images : Données rasters

QGIS_GO03 - Ouverture de protocoles Internet — WebServices (WMS, WEFS...)

QGIS_G04 - Connexion et gestion de bases de données
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OGIS_GO01 - Ouverture de données tabulaires (txt, csv, dbf), GPS et autres

s )Ouvrir ou exporter des données tabulaires ou données vectorielles externes

1l est aussi d’ouvrir de multiples données, qu’elles SOIENt iy ai i raion,  Taf-fEFE
vectorielles ou tabulaires a partir du menu Couche> .
Ajouter une couche vecteur (fiche BO1). Vous pouvez
ainsi importer tous les types de fichiers listés ci-contre.
Vous pouvez par exemple accéder aux fichiers Maplnfo
(TAB) ou interchangeables MIF/MID.

Les données tabulaires sont des données attributaires ; elles
ne possedent pas de données géographiques (pas
d’entités !).
QGIS vous offre la possibilité d’ouvrir directement des
fichiers DBF, des fichiers CSV* ou texte (TXT). Les
fichiers s’ouvrent alors tels que s’ouvrent des couches
(fiche BO1) ; il faut de choisir le Type de fichier adéquat
dans la fenétre d’ouverture (, pour
pouvoir voir votre fichier dbf par exemple).
Un fichier XLS bien construit peut s’ouvrir directement,
comme un DBF
Vous pouvez ensuite gérer la table comme une table
attributaire de couche géographique classique.
La table est alors accessible dans la liste des couches a gauche de la vue
- FETEppar (méme s’il n’existe aucune vue associée a cette table), avec un
PR T pictogramme spécifique, comme présenté ci-contre :

ttention : La plupart des données tabulaires ou vectorielles externes sont en lecture seule.
~ Vous pouvez exporter ces données telle une couche sans donnée géographique, a partir du
menu Couche> Sauvegarder sous, lorsque la table est active (surlignée).

& i])onnées GPS

7 Dans la plupart des cas les systémes de positionnement par satellites type GPS permettent de récupérer

des fichiers de points au format ASCII (format texte) ou GPX, a partir du menu Couche> Ajouter
une couche vecteur (fiche BO1). Si les données ne sont pas directement transférables au logiciel
SIG I’extension GPS (installée par défaut) du menu Vecteur peut vous aider.

@ \iA cquérir des données géographiques a partir de tables attributaires :
Ci

ertaines données ne présentent pas d’objets géographiques mais ceux-ci peuvent étre construits si on
connait leur localisationen X eten Y.
La présence de coordonnées X et Y dans les champs de la table va nous permettre de créer
pour chaque ligne du tableau un point avec les coordonnées correspondantes.
A partir du menu Couche> Ajoutez une couche > Ajoutez une couche de texte délimité
vous pouvez spécifier les données géographiques (X et Y) d’un fichier TXT ou CSV.
N’oubliez pas que les coordonnées présentes dans la table, doivent impérativement étre dans
le méme systeme de projection que la Vue dans laquelle vous travaillez !
Astuce : Si vous disposez d’un fichier autre que CSV/TXT, enregistrez votre fichier en CSV,
puis créez les points a partir du fichier CSV créé.

% Le fichier CSV est éditable/créable avec un éditeur de texte. La premiére ligne doit contenir les champs des
colonnes, séparés par « ; » (un point-virgule), les lignes suivantes les données, séparées aussi par « ; ».
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OGIS_GO02 - Géoréférencement d’images : Données rasters

S —

gOuvrlr Poutil
Vous n’avez pas besoin d’ouvrir I’image avant de la géoréférencer.
Utilisez I’extension (installée par défaut) Géoréférencer du menu
Raster> Géoréférencer pour commencer le géoréférencement.

3Ouvrir 'image
La partie supérieure contiendra alors votre image, alors que la partie
inférieure contiendra la Table des points de controle (points de géoréférencement).
Dans la fenétre Géoréférencer, ouvrez I’image a géoréférencer (Fichier> Ouvrir un raster).

¢ySpécifier la projection

~ A I’ouverture de I’image, une fenétre apparait invariablement pour vous demander le systeme
de projection de votre image (utilisez la fiche B04 si besoin pour attribuer la projection).

gA‘]outer des points de calage
Dans cette fenétre Géoréférenceur, pour ajouter un
point de calage, cliquez d’abord sur 1’outil Ajouter
un point 4 Une nouvelle fenétre s’ouvre, vous |+
permettant deux types de géoréférencement.

i

Type de géoréférencement

Cas 1 : Vous connaissez les coordonnées des points a géoréférencer

Entrez-les manuellement dans X et Y. Les coordonnées « image » (pixels) s’ajoutent dans sreX et
srcY de la partie Table des points de contréle ; les nouvelles coordonnées dans dstX et dstY.

Cas 2 : Vous utilisez la vue pour caler I’image

Choisissez & fepsisraaiamalaculs 5y Jieu d’entrer manuellement les coordonnées. Le logiciel pointe
alors la vue courante ol vous pouvez choisir I’endroit réel auquel correspond le point fraichement
choisi. Les sreX et srcY se remplissent automatiquement avec les coordonnées, dans le systeéme de
projection de la vue en question !

. & .
Lors du géoréférencement, vous pouvez modifier *«* ou supprimer ? le placement d’un
point. Les outils de zoom classiques sont disponibles pour vous déplacer sur la carte.

QE’Spemfier le type de transformation
Avant de commencer le géoréférencement, vous devez indiquer le type de transformation et le

Raster de sortie dans le menu Parametres> Parametres de transformation.

. Type de transformation
On utilise une transformation affine lorsque 'image a référencé est dans la méme projection que I’image de
référence (4 points suffisent). On utilise les transformations polynomiales lorsque les déformations sont importantes
(cartes napoléoniennes...). Vous avez besoin d’un minimum de quatre points pour une transformation polynomiale
de premier ordre, six pour une transformation de second ordre et dix pour une transformation de troisi¢me ordre.
‘ Remarque : Un grand nombre de points n’améliore pas forcément la qualité du résultat, préférez donc des points

pres de chaque angle de 1’image a référencer et quelques points au centre. N’alignez pas vos points.

Mg s ey

gEnreglstrement du géoréférencement :
Des que vous avez placé 4 points de calage (===

(non alignés et éloignés du centre de 1’image), : 1 i ::.:_.1 .;,:1" oot B W

le logiciel calcule le géoréférencement: il |w = L S A 1 i

déplace légerement les points (dX et dY) et = |1 1=rwwbesmsn s an as g
. i CEOTE LT e TIER <2 T

affiche I’erreur associée (residual).
Lorsque ceux-ci sont acceptables (le plus faible possible), vous pouvez enregistrer le raster
résultant a partir du menu Fichier> Commencer le géoréférencement.
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— Les protocoles Internet cartographiques

0OGIS_GO03 - Ouverture de protocoles Internet — WebServices (WMS, WFS...)

Cette page aborde les connexions sur
Internet. Si votre ordinateur est derriere
un Proxy, il est indispensable de
paramétrer le Proxy dans QGIS, depuis le
menu Préférences> Options, puis onglet
Réseau, pour afficher la fenétre ci-contre,
cocher Utiliser un proxy pour I’acces
Internet, et paramétrer ce Proxy.
Rapprochez-vous de votre administrateur
réseau si besoin.

sont des services qui diffusent | i i
(gratuitement ou non), des cartes et :ﬂ TR,
données disponibles au travers du logiciel =
SIG. ! o ]
L’avantage de ces services est de ne pas devoir stocker les données (souvent trés lourdes) sur
I’ordinateur, et de pouvoir superposer ces services a vos données locales.

5 QGIS offre la possibilité d’en afficher plusieurs d’entre eux (WMS, WES ...).

Pour accéder a ces services, il suffit de :
1- Entrer I’adresse Internet du service
2- Choisir les données dont on a besoin
3- Paramétrer le rendu des données

L’ajout d’une couche WMS est accessible directement depuis le menu Couche> Ajouter une
couche> Ajouter une couche WMS.

Connexion aux protocoles de services WMS

=
!

[P ——— =ik

—..e. 2—Choix des données
dlsponlbles surle serVIce

Timad s e &

" Choix des couches

Tum aee e o ) i _u
- b [\ i
- \ / =i _ = Format d'image

e i e e 5 e, Projection e

[P [T

i = T e = =3

3 — Format de restitution

D’autres services tels que I’ajout de couche WFS sont accessibles selon la méme procédure depuis le
menu Couche> Ajouter une couche, puis choisir le type de service distant désiré, et le configurer
pour s’y connecter et charger les données souhaitées.

De nombreux services sont accessibles directement dans QGIS ; beaucoup de pages Internet listent ces
services (exemple : http://sigea.educagri.fr/donnees/serveurs-distants-wms.html)
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0GIS_G04 — Connexion et gestion de bases de données

@Lcs bases de données (BDD) sont un avantage certain dans le stockage et I’automatisation des
analyses de la donnée.
11 est possible de se connecter a une BDD locale ou distante ; il s’agit de bien paramétrer la
connexion. QGIS offre la possibilité de se connecter a de nombreuses bases de données
géographiques en lecture et écriture des données (il faut connaitre les parametres de

connexion — a demander a I’administrateur).

PostgreSQL / PostGIS Connexion a une base de données PostgreSOL / PostGIS
PostGIS est I’extension spatiale de e —
PostgreSQL. = . . . .. 2-Choix des données
QSe connecter et ajouter une table = 1| disponibles la base de données
PostGIS se‘reahse depuis le menu 1 - Connexion | = E
Couche >Ajouter une couche L == = e
>Ajouter une couche PostGIS. )&'_'T"_ /g—- o S TS
Exemple de connexion a une base de = - E - - e T
données locale existante : = ’ k- = ;;: = E
- Nom : choisir un nom e = = H
- Héte : localhost Bt B B 5 i
- Port : 5432 oS el ; ;
- Base de données : postgres e - :
- Nom d’utilisateur : postgres T R P - =
- Mot de passe : postgres T Schéma \ Tables ] clé p,im;ire
SpatiaLite — i
Zgmer ! “F% SpatiaLite est l'extension spatiale de
":'"_ e R ke e e e Sqlite. Contrairement a un SGBD lourd
Py P tel que PostgreSQL / PostGIS, une base

— - | de données SpatiaLite est contenue dans
un seul fichier facilement « portable ».
Depuis le menu Couche >Ajouter une
couche >Ajouter une couche SpatiaLite,
créer une nouvelle connexion, puis parcourir
les dossiers jusqu’a I’emplacement du fichier
(*.sqlite)

e -t L’ensemble des couches disponibles
iy [kl s s [ s’affiche.

Base déconnectée

L’extension «édition hors connexion » (menu Extension pour charger I’extension, menu
Bases de données pour I’utiliser), permet de synchroniser une BDD SpatiaLite embarquée
(utile lors de saisie sur le terrain) a une BDD PostGIS (base centralisée, partagée, administrée
ou les droits d’acces peuvent étre gérés).

el
Gestion des tables et bases

Lorsque les bases de données sont connectées
une premiere fois, elles sont toutes
accessibles depuis I’extension DB Manager
(installée par défaut), depuis le menu Bases
de données > Gestionnaire de bases de
données pour une gestion centralisée et
simplifiée des tables disponibles.

g i e
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GARMIN.
Série GPSMAP" 78

Manuel de démarrage rapide

~ autiliserave les n° SMAP 78,
GPSMAP 78s et GPSMAP 78sc
!I - .__g_ &“l

Mise en route

/\AVERTISSEMENT
Consultez le guide Informations
importantes sur le produit et la sécurité
inclus dans l'emballage du produit pour
prendre connaissance des avertissements et
autres informations sur le produit.

Lors de la premiere utilisation du produit,
vous devrez effectuer les opérations
suivantes pour configurer I'appareil et vous
familiariser avec les fonctions de base.

1. Installation des piles (page 2).

2. Mise en route de I'appareil (page 3).

3. Acquisition des signaux satellites
(page 3).

4, Marquage d'un waypoint (page 5).

5. Etalonnage du compas (page 7).

6. Navigation a l'aide du menu de
recherche (page 8).
7. Suivi d'un itinéraire (page 9).

Informations
supplémentaires

Vous pouvez vous rendre sur le site
www.garmin.com pour télécharger les
derniers manuels.

Distance de sécurité du
compas

Installez le GPSMAP 78 a au moins

20,3 cm (8 pouces) de tout compas. Testez
votre compas pour vous assurer qu’il
fonctionne correctement lorsque I’appareil
est en marche.

Informations sur les piles
L'appareil fonctionne a I'aide de deux piles
AA. Utilisez des piles alcalines, NiMH ou
au lithium. Pour des résultats optimaux,
utilisez des piles NiMH ou au lithium
préchargées.

Installation des piles

1. Faites glisser le clip de verrouillage
situé au dos de I'appareil et retirez le
cache du compartiment a piles.

Manuel de démarrage rapide du GPSMAP 78
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2. Insérez les piles en respectant la
polarité.

3. Remettez le cache du compartiment a
piles en place.

Pour de meilleurs résultats, lorsque vous
installez des piles neuves dans l'appareil,
mettez a jour le type de batterie dans les
paramétres systéme (page 10).

Mise sous/hors tension de
I'appareil

Maintenez le bouton (') enfoncé.
Configuration de la langue
1. Mettez l'appareil sous tension.

2. Alaide du pavé directionnel,
sélectionnez une langue.

Manuel de démarrage rapide du GPSMAP 78

Acquisition de signaux
satellites

La procédure d'acquisition des signaux peut

prendre de 30 a 60 secondes.

1. Placez-vous a l'extérieur dans une zone

dégagée.
2. Sinécessaire, mettez I'appareil sous
tension.

3. Attendez pendant que I'appareil
recherche des satellites.
Un point d'interrogation clignote
pendant que l'appareil détermine votre
position.

4. Appuyez rapidement sur le bouton (')
pour ouvrir la page d'état du
rétroéclairage.

Les barres GPS indiquent la puissance
des signaux satellites. Lorsque les
barres sont vertes, l'appareil capte des
signaux satellites.

PAGE Appuyez sur le bouton PAGE
pour faire défiler les pages
principales (page 5).

MENU Appuyez sur le bouton MENU

pour ouvrir le menu d'options
de la page ouverte.

Appuyez deux fois sur le bouton
MENU pour ouvrir le menu
principal (a partir de n'importe

quelle page).

FIND/MOB | Appuyez sur le bouton FIND ENTER/ Appuyez sur ENTER pour
pour ouvrir le menu de MARK sélectionner les options et
recherche. pour accuser réception de
Maintenez le bouton MOB messages.

(fonction homme a la mer) Maintenez le bouton MARK
enfoncé pour enregistrer enfoncé pour enregistrer
votre position actuelle comme votre position actuelle comme
waypoint et commencer la waypoint.
navigation vers ce point. , A

Pavé Appuyez sur les fléches haut,

d) Maintenez le bouton d) direction- bas, droite et gauche pour
enfoncé pour mettre I'appareil nel sélectionner les options de
sous et hors tension. menu et déplacer le curseur sur
Appuyez rapidement sur le la carte.
bouton (%) pour ouvrir la page + Appuyez sur le bouton + pour
d'état du rétroeclairage. effectuer un zoom avant sur

Quit Appuyez sur le bouton QUIT la carte.

pour annuler une commande ou
revenir au menu ou a la page
précédent(e).

- Appuyez sur le bouton - pour
effectuer un zoom arriére sur
la carte.

Manuel de démarrage rapide du GPSMAP 78
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Waypoints

Les waypoints sont des positions que vous
enregistrez et gardez en mémoire dans
l'appareil.

Création de waypoints

1. A partir de n'importe quelle page,
maintenez le bouton MARK enfoncé.

2. Sélectionnez Terminé.

Modification d'un waypoint
Avant de pouvoir modifier un waypoint,
vous devez le créer.

1. Dans le menu principal, sélectionnez
Gestionnaire de waypoints.
Sélectionnez un waypoint.

3. Sélectionnez un attribut (nom ou
position par exemple).

4. Entrez les nouvelles informations.

5. Sélectionnez Terminé.

Suppression d'un waypoint
1. Dans le menu principal, sélectionnez
Gestionnaire de waypoints.
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2. Sélectionnez un waypoint.
3. Appuyez sur MENU.
4. Sélectionnez Supprimer.

Pages principales

Les informations nécessaires a l'utilisation
de l'appareil se trouvent dans les pages
suivantes : carte, compas, menu principal et
calculateur de voyage.

Carte

L'icone de position ‘ représente votre
position sur la carte. Lorsque vous vous
déplacez, l'icone de position se déplace et
établit un journal de suivi (trace). Les noms
et les symboles des waypoints apparaissent
¢galement sur la carte.

Modification de I'orientation de la

carte

1. Sur la page Carte, appuyez sur le
bouton MENU.

2. Sélectionnez Paramétrage carte >
Orientation.

3. Sélectionnez une orientation :

e Sélectionnez Nord en haut pour
afficher le nord en haut de la page.

*  Sélectionnez Tracé en haut pour
afficher votre direction actuelle en
haut de la page.

*  Sélectionnez Mode Automobile
pour afficher une vue en
perspective.

Mesure de la distance

Vous pouvez déplacer le curseur sur la carte
pour mesurer une distance par rapport a
votre position actuelle.

1. Sur la page Carte, appuyez sur le
bouton MENU.

2. Sélectionnez Mesurer distance.

L'appareil commence automatiquement
a mesurer la distance a partir de votre
position actuelle.

3. Déplacez le curseur jusqu'au point &
mesurer.

La distance s'affiche en haut de la page.

4. Appuyez sur QUIT pour arréter la
mesure.

Compas

Lorsque vous naviguez vers une
destination, le pointeur de relévement ‘
pointe vers votre destination, quelle que
soit la direction dans laquelle vous vous
dirigez. Si le pointeur de relévement pointe
vers le haut du compas électronique, cela
signifie que vous vous dirigez dans la
bonne direction. S'il pointe dans une autre
direction, tournez-vous jusqu'a ce que la
fléche pointe vers le haut du compas.
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Etalonnage du compas

REMARQUE

Etalonnez le compas électronique

en extérieur. Eloignez-vous de toute
interférence éventuelle avec le champ
magnétique terrestre, qui peut provenir
des voitures, des batiments ou des lignes
électriques aériennes.

REMARQUE : le compas a trois axes est
disponible uniquement sur les modeles
GPSMAP 78S et GPSMAP 78Sc.

Vous devrez étalonner le compas apres
avoir parcouru de longues distances, apres
un changement important de température
ou apres avoir changg les piles.

1. Sur la page Compas, appuyez sur le
bouton MENU.

2. Sélectionnez Etalonner compas >
Démarrer.

3. Suivez les instructions présentées a
I'écran.
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Etalonnage de I'altimétre
barométrique

REMARQUE : la page Profil d'altitude
est disponible uniquement sur les modeles
GPSMAP 78S et GPSMAP 78Sc.

Vous pouvez étalonner manuellement
l'altimetre barométrique si vous connaissez
I'altitude ou la pression correcte.

1. Sur la page Profil d'altitude, appuyez
sur le bouton MENU.

2. Sélectionnez Etalonner altimétre.

3. Suivez les instructions présentées a
I'écran.

Calculateur de voyage

Le calculateur de voyage affiche vos
vitesse actuelle, vitesse moyenne, vitesse
maximale, odometre de trajet, ainsi que
d'autres statistiques utiles.

Personnalisation des
champs de données

Les champs de données de chaque page
principale peuvent étre personnalisés.

Pour obtenir une description des champs de
données, consultez le Manuel d'utilisation
du GPSMAP 78.

1. Sur une page principale, appuyez sur le
bouton MENU.

Sélectionnez Modifier champs.
Sélectionnez un champ de données.
Appuyez sur le bouton ENTER.

Suivez les instructions présentées a
I'"écran.

SANEE e

A propos des tracés

Votre appareil Garmin enregistre un journal
de suivi lorsque vous vous déplacez. Vous
pouvez enregistrer ces tracés en vue de les
utiliser pour un itinéraire ultérieur.

Navigation vers un waypoint
a l'aide du menu de
recherche

Le menu de recherche permet de rechercher
rapidement des waypoints, des tracés, des
itinéraires et des coordonnées enregistrés.

1. A partir de n'importe quelle page,
appuyez sur le bouton FIND.

2. Sélectionnez Waypoints.

3. Sélectionnez un waypoint.

4. Sélectionnez Aller.

Modification de votre
méthode de guidage

Vous pouvez sélectionner une méthode

de guidage pour naviguer a vol d'oiseau,
pour suivre les routes ou pour obtenir des
instructions chaque fois que vous naviguez.

1. Dans le menu principal, sélectionnez
Configuration > Définition
d'itinéraires > Méthode de guidage.

2. Sélectionnez une option.
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Création d'un itinéraire

1. Dans le menu principal, sélectionnez
Calculateur d'itinéraire > Créer
itinéraire > Sélectionner ler point.

2. Sélectionnez une catégorie.

3. Sélectionnez le premier point de
l'itinéraire.

4. Sélectionnez Utiliser.

5. Sélectionnez Sélectionner point
suivant.

6. Répétez les étapes 2 a 5 jusqu'a ce que
l'itinéraire soit terming.
Un itinéraire doit contenir au moins
deux points.

7. Appuyez sur QUIT pour enregistrer
l'itinéraire.

Suivi d'un itinéraire

1. Appuyez sur le bouton FIND.

2. Sélectionnez Itinéraires.

3. Sélectionnez un itinéraire.
4. Sélectionnez Aller.
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Utilisation de la fonction
Voir&rallier
REMARQUE : Ia fonction Voir&rallier

est uniquement disponible sur les modéles
GPSMAP 78S et GPSMAP 78Sc.

Vous pouvez pointer I'appareil vers un objet

situé a distance (un phare par exemple),

verrouiller la direction, puis naviguer vers

l'objet.

1. Dans le menu principal, sélectionnez
Voir&rallier.

2. Pointez 'appareil vers l'objet.

3. Sélectionnez Verrouiller direction >
Définir parcours.

4, Utilisez le compas pour naviguer vers
l'objet.

Fixation de la dragonne

I. Glissez « =—
la Rhs
boucle
dela
dragonne
dans la fente située
au bas de 'appareil.

2. Enfilez la dragonne dans la
boucle, puis serrez.

Optimisation de I'autonomie
des piles

Utilisation de I'option Economie
d'énergie

Utilisez I'option Economie d'énergie pour
¢conomiser les piles et prolonger leur durée
de vie.

Dans le menu principal, sélectionnez
Configuration > Ecran > Economie
d'énergie > Activé.
Diminution du rétroéclairage
L'utilisation prolongée du rétroéclairage
de I'écran réduit considérablement la durée
de vie des piles. Vous pouvez régler la

10

luminosité du rétroéclairage et réduire sa
temporisation afin d'optimiser I'autonomie
de l'appareil.

1. Appuyez rapidement sur le bouton
(" pour ouvrir la page d'état du
rétroéclairage.

2. Utilisez le pavé directionnel pour
régler la luminosité.

Réglage de la temporisation du
rétroéclairage
Dans le menu principal, sélectionnez
Configuration > Ecran >
Temporisation rétroéclairage.

Sélection du type de batterie

1. Dans le menu principal, sélectionnez
Configuration > Systéme > Type de
batterie.

2. Sélectionnez Alcaline, Lithium ou
NiMH rechargeable.

Stockage a long terme

Si vous ne prévoyez pas d'utiliser I'appareil
pendant plusieurs mois, retirez les piles.
Les données stockées restent en mémoire
lorsque les piles sont enlevées.
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Enregistrement de I'appareil
Aidez-nous a mieux vous servir en
remplissant dés aujourd'hui notre
formulaire d'enregistrement en ligne.

e Visitez le site Web a l'adresse suivante :

http://my.garmin.com.

» Conservez en lieu sir l'original de la
facture ou une photocopie.

Réinitialisation de I'appareil
Si I'écran ou les boutons de votre
GPSMAP 78 ne répondent plus, vous
pouvez réinitialiser le périphérique.

1. Retirez les piles.
2. Réinstallez les piles (page 2).

REMARQUE : ceci n'efface aucune
donnée ou paramétre.

Mise a jour du logiciel
1. Rendez-vous sur le site www.garmin
.com/products/webupdater.

2. Suivez les instructions présentées a
I'écran.
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REMARQUE : Ceci n'efface aucune
donnée ou parametre.

Contacter lI'assistance
produit de Garmin

Vous pouvez contacter 'assistance produit
de Garmin pour toute question concernant
ce produit.

Aux Etats-Unis, rendez-vous sur le site
WWWw.garmin.com/support ou contactez
Garmin USA par téléphone, au (913)
397 8200 ou au (800) 800 1020.

*  Au Royaume-Uni, contactez Garmin
(Europe) Ltd. par téléphone au 0808
2380000.

» En Europe, rendez-vous sur le site
Www.garmin.com/support et cliquez
sur Contact Support pour obtenir
l'assistance requise dans votre pays ou
contactez Garmin (Europe) Ltd. par
téléphone au +44 (0) 870 850 1241.
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Garmin®, le logo Garmin et GPSMAP® sont des marques commerciales de Garmin Ltd. ou de ses filiales,
déposées aux Etats-Unis et dans d'autres pays. Elles ne peuvent étre utilisées sans I'autorisation expresse de
Garmin.
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Tutoriel sur I'extension de classification semi-automatique (SCP)

Ce tutoriel se fonde sur un exercice visant a identifier 4 utilisations des terres sur une image
satellite :

Eau (Water);

Batiments et infrastructures (Built-up);
Végétation (Vegetation);

Sols nus (Bare soil).

rPwopop

1. Données
L’exercice mobilise des données téléchargeables a I'adresse :

https://docs.google.com/uc?id=0BysUrKXWIDwBNEtudThrcWIERDg.

I s'agit d'une image Landsat incluant les bandes suivantes :

Bleu

Vert

Rouge

Proche infrarouge
Infrarouge court 1
Infrarouge court 2

o s w N p

2. Choisir I'image d’entrée dans SCP

Dans la section SCP input, cliquer sur le bouton ' de la sous-section Input image.
Sélectionner le fichier sample_image.tif téléchargé.

Une fois sélectionné, le fichier est affiché et ses bandes sont listées (onglet Band set du
SCP).

Il est possible d'afficher une image composite en utilisant des bandes sélectionnées parmi
les bandes listées :

= 3-2-1pour les couleurs naturelles,

" 4-3-2 pour une image composite Proche infrarouge/Rouge et Vert, qui permet de
mettre en valeur la végétation en rouge vif.
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Image composite : RGB = 4-3-2
3. Création du fichier d’entrainement

Le fichier d’entrainement permettra de stocker des Zones d’entrainement (ROl pour Region
of Interest — régions d'intérét). Les signaux spectraux de chaque ROI seront calculés et
utilises pour la classification.

o
Dans a sous-section Training input de la section SCP input, cliquer sur! | et nommer le
fichier a enregistrer (training.scp dans I'exemple). Une couche vecteur est ajoutée au projet
QaGls.

SCPBock Kpi A

SCP input

INoUt Image

ﬁ g | sample_image.tf vj{e))

Tralning ingut.

Définition du fichier d’enregistrement

4. Création des ROI

I s'agit maintenant de créer les ROI, en définissant les Classes et Macroclasses. Chaque ROI
identifie une utilisation des terres grace a un identifiant de classe (Class ID). Les classes
utilisées dans ce tutoriel sont reprises dans le tableau suivant :

Francais Anglais |
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|Nom de laclasse ‘Identifiant de laclasse ‘Class name |Class 1D

| Eau ‘ 1 ‘ Water | 1
| Batis \ 2 CBuiltup | 2 |
| Végétation ‘ 3 ‘Vegetation | 3 ‘
| Sol nu ‘ 4 ‘ Bare soil | 4 ‘

Les ROI peuvent étre crées manuellement en dessinant des polygones, ou grace a un
algorithme automatique.

Zoomer dans la zone sombre au sud-est de la carte : il s'agit d'un lac. Afin de créer une ROI
—
manuellement dans ce lac, sélectionner le bouton L .. Les points définissant le polygone

sont ajoutés avec un clic gauche sur la carte et le polygone est fermé par un clic droit.

Un polygone orange est affiché sur I'image. Il s'agit d'un polygone temporaire (non
sauvegardé dans le fichier d’entrainement pour le moment). Le polygone peut étre refait
jusqu'a ce qu'il soit considéré comme satisfaisant.

Une ROI créée manuellement
Quand la ROI est considérée comme satisfaisante, ouvrir le Classification dock pour définir
les Classes et Macroclasses. Dans ROI creation, paramétrer MC ID = 1 et MC Info = Eau, ainsi

que C ID = 1 et C Info = Lac. Cliquer sur E pour sauvegarder la ROI dans le fichier
d’entrainement.

Aprés quelques secondes, la ROI est listée dans la liste des signatures des ROl (ROI/

Signature list) et a signature spectrale est calculée si I'option Calculate sig. A été cochée .
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La ROl sauvegardée dans le fichier d’entrainement

Le champ C ID dans ROI creation est automatiquement augmenté de 1. La ROl enregistrée
est affichée comme un polygone sombre sur la carte.

Une ROI pour les zones baties sera créée avec I'outil automatique. Zoomer sur la carte vers
la zone bleue au Nord Ouest de la carte.

Dans la barre des taches, régler le paramétre Dist a 0,08. Cliquer sur le bouton |_| de la
barre des taches et cliquer sur la zone bleue de la carte. Un polygone orange (temporaire)
est alors affiché sur la carte. Jouer sur le paramétre Dist afin de modifier la surface du

polygone (le bouton [—] permet d’actualiser le calcul).
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Une ROI temporaire créée avec l'algorithme automatique

Dans RO creation, paramétrer MC ID = 2 et MC Info = Batis, ainsi que C ID = 2et C Info =
Immeubles.

ol p e o Bieg - Bigh

CEEmEs

S LI L ) 15
La ROl sauvegardée dans le fichier d’entrainement

Créer une ROI pour la classe Végétation (pixels rouge dans I'image composite 4-3-2) et une
ROI pour la classe Sol nu (pixels verts dans I'image composite 4-3-2), en suivant les étapes
décrites précédemment. Les images suivantes montrent des exemples de ces classes
identifiées sur la carte.
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Les exemples suivants illustrent quelques I'affichage d’'images composites.

RGE = 4:3<2

ROl bitis : Grands immeubles

AGE = .33 RiGE = 34§

RS~ 3-3-2 Al - 348

ROI bdtis : Immeubles et routes étroites

FO8 = 3-3-2 FGE & Jeiaf

ROI Sols nus : Terres non cultivées

EGE = 3=l 08 = §-3:2 RGE & 3l

ROI Végétation : Feuillus

NGH = 4-5.3

ROI Végétation : Terres cultivées
5. Création d'un apergu de la classification

Le processus de classification est basé sur les ROl renseignées et leurs signatures spectrales.
Il est utile de créer un aperqu de la classification pour évaluer les résultats avant de lancer la
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classification (qui peut étre longue). Ainsi, il est possible d'affiner la classification en
collectant de nouvelles ROl si nécessaire avant de lancer la classification compléte.

Avant d'initier la classification ou I'aperqu, paramétrer les couleurs des classes d'utilisation
des terres qui seront affichées dans le raster de classification. Dans la liste des signatures
des ROI, double-cliquer sur la couleur de chaque ROI pour choisir une couleur représentative
de chaque classe.
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Définition des couleurs des classes

Il faut ensuite sélectionner I'algorithme de classification. Pour cet exercice, nous choisirons
I'algorithme Spectral Angle Mapping.

Dans la section Classification algorithm, sélectionnée I'algorithme Spectral Angle Mapping.
Dans la section Classification preview, paramétrer la taille (size) a 5oo. Cliquer sur le bouton

puis faire un clic gauche sur une zone de la carte. Une portion de la carte sera alors
traitée par I'algorithme de classification.
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Apercu de la classification affiché sur la carte

Les apergus sont des rasters temporaires. Il est recommandé de générer un apercu a chaque
fois qu'une ROI est définie, afin de visualiser I'amélioration de la classification.

6. Lancement de la classification

Si I'aperqu est jugé satisfaisant, la classification peut étre lancée. Dans la section

.\'I
Classification output, cliquer sur le bouton g et définir le dossier de destination.
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Résultat de la classification

L'eau et la végétation sont correctement identifiées. Cependant, il y a de nombreuses
erreurs de classification, en particulier des terrains nus classés comme bétis, et inversement.
Ceci est d0 a un trop faible nombre de ROI déterminées.

Exemple d’erreur : Sol nu classé comme Batis
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